
Read this manual carefully before you use this product and keep it handy for future

reference.

For safety, please follow the instructions in this manual.

OPERATING INSTRUCTIONS
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Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Note

The names of the applications do not appear in the following pages. Confirm which applications you
will be using before reading this manual.

Power Source

220-240 V, 50 Hz/60 Hz, 6.0 A or more

Please be sure to connect the power cord to a power source as above.

Operator Safety:

This machine is considered a class I laser device, safe for office/ EDP use. The machine contains 5-
milliwatt, 760 - 800 nanometer wavelength, GaAIAs laser diodes. Direct (or indirect reflected) eye con-
tact with the laser beam might cause serious eye damage. Safety precautions and interlock mecha-
nisms have been designed to prevent any possible laser beam exposure to the operator. 

The following label is attached on the back side of the machine.

Laser Safety:

The optical housing unit can only be repaired in a factory or at a location with the requisite equipment.
The laser subsystem is replaceable in the field by a qualified Customer Engineer. The laser chassis is
not repairable in the field. Customer engineers are therefore directed to return all chassis and laser sub-
systems to the factory or service depot when replacement or the optical subsystem is required.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Caution:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Do not attempt any maintenance or troubleshooting other than that mentioned in this manual. This ma-
chine contains a laser beam generator and direct exposure to laser beams can cause permanent eye
damage.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Ricoh shall not be responsible for any damage or expense that might result from the use of parts other
than genuine Ricoh parts in your Ricoh office product. 

For good copy quality, Ricoh recommends that you use genuine Ricoh toner.

Descriptions in this manual Application

PRINTER MANAGER FOR ADMINISTRATOR Aficio Manager for Admin

PRINTER MANAGER FOR CLIENT Aficio Manager for Client

  CLASS 1 LASER PRODUCT

IN ACCORDANCE WITH IEC 825

LASER KLASSE 1 nach IEC 825



Declaration of Conformity

“The Product complies with the requirements of the EMC Directive 89/336/EEC and the Low Voltage
Directive 73/23/EEC.”

Caution (in case of 100BaseTX environment):

1. Properly shielded and grounded cables (STP) and connectors must be used for connections to host
computer (and/or peripheral) in order to meet EMC Directive 89/336/EEC emission limits.

2. STP with ferrite core must be used for RF interference suppression.

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 

a means POWER ON.

b means POWER OFF.

Copyright © 1999 Ricoh Co., Ltd.
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Trademarks

Microsoft®, Windows®, and MS-DOS® are registered trademarks of Microsoft
Corporation in the United States and/or other countries.

PostScript® is a registered trademark of Adobe Systems, Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.

AppleTalk, Apple, Macintosh, TrueType, LaserWriter are registered trademarks
of Apple Computer, Incorporated.

Ethernet® is a registered trademark of Xerox Corporation.

PowerPC is a registered trademark of International Business Machines Corpora-
tion.

Other product names used herein are for identification purposes only and might
be trademarks of their respective companies. We disclaim any and all rights in-
volved with those marks.

Notes:

Some illustrations might be slightly different from your machine.

Certain options might not be available in some countries. For details, please con-
tact your local dealer.

Note

The proper names of the Windows operating systems are as follows:

• Microsoft® Windows® 95 operating system

• Microsoft® Windows® 98 operating system

• Microsoft® Windows® for Workgroups operating system Version 3.11

• Microsoft® Windows NT® Server network operating system Version 4.0

• Microsoft® Windows NT® Workstation operating system Version 4.0
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Safety Information

When using your equipment, the following safety precautions should always be
followed.

Safety During Operation

In this manual, the following important symbols are used: 

R WARNING:
Indicates a potentially hazardous situation which, if instructions 
are not followed, could result in death or serious injury.

R CAUTION:
Indicates a potentially hazardous situation which, if instructions are 
not followed, may result in minor or moderate injury or damage to 
property.
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R WARNING:

 
• Connect the power cord directly into a wall outlet and never use an ex-

tension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the 
power cable or plug becomes frayed or damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this man-
ual.

• Turn off the power and disconnect the power plug (by pulling the 
plug, not the cable) if any of the following conditions exist:

• You spill something into the equipment.

• You suspect that your equipment needs service or repair.

• Your equipment's cover has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust is flammable 
and might ignite when exposed to an open flame.

• Disposal should take place at an authorized dealer or appropriate col-
lection site.

• If you dispose of the used toner containers yourself, dispose of them 
according to local regulations.
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R CAUTION:

 
• Protect the equipment from dampness or wet weather, such as rain, snow, 

and so on.

• Unplug the power cord from the wall outlet before you move the equipment. 
While moving the equipment, you should take care that the power cord will 
not be damaged under the equipment.

• When you disconnect the power plug from the wall outlet, always pull the 
plug (not the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall in-
side the equipment.

• Do not eat or swallow toner.

• Keep toner (used or unused) and toner cartridge out of reach of children.

• For environmental reasons, do not dispose of the equipment or expended 
supplies at a household waste collection point. Disposal sould take place 
at an authorized dealer or an appropriate collection site.

• Our products are engineered to meet the highest standards of quality and 
functionality. When purchasing expendable supplies, we recommend using 
only those specified by an authorized dealer.

• The inside of the machine becomes very hot. Do not touch the parts with a 
label indicating a “hot surface”. Touching a “hot surface” could result in a 
burn injury.
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ENERGY STAR Program

❖ Low-power mode (Energy Saver mode)
 This printer automatically lowers its power consumption 1 hour after the last
operation has been completed. To exit Low-power (Energy Saver) mode,
press any key on the operation panel. To change the setting of the Energy Sav-
er mode, see P.129 “Using the Operation Panel”.

❖ Specifications

-Recycled Paper

Please contact your sales or service representative for recommended recycled
paper types that may be used in this machine.

As an ENERGY STAR Partner, we have deter-
mined that this machine model meets the ENER-
GY STAR Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving sys-
tem for developing and introducing energy-efficient office equipment to deal with en-
vironmental issues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Part-
ner shall place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office 
equipment by means of energy-saving features, such as Low-power mode.

The ENERGY STAR Guidelines intend to establish an international energy-saving 
system for developing and introducing energy-efficient office equipment to deal with 
environmental issues, such as global warming.

This product was designed to reduce the environmental impact associated with office 
equipment by means of energy-saving features, such as Low-power mode.

Lower-power mode

(Energy Saver mode)

Power Consumption 45 W or less

Default Time  1 hour 

Recovery Time 100 seconds or less
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Manuals for Your Printer

Manuals for Your Printer

There are three manuals that come with this printer.

To enhance safe and efficient operation of your printer, all users should read and
follow the instructions contained in the following manuals.

❖ Quick Installation Guide
Describes the procedures for installing your printer.

❖ Operating Instructions
Describes the procedures and necessary information on setting up and using
your printer and its options. (This Manual)

❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features you can set using the PostScript printer
driver. The manual is provided as a PDF file which is included in the CD-
ROM labeled “Printer Drivers and Utilities”.



vii

How to Read this Manual

Symbols

In this manual, the following symbols are used:

R WARNING:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[        ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.

{   }
Keys built into the machine's operation panel.

Keys on the computer's keyboard.
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1. Getting Started

Printer Features 

This printer is designed especially for office work groups. It can be used for net-
work environments and allows you to handle documents efficiently.

❖ High Performance
The new 45 print per minute (ppm) engine with PowerPC 603 100 MHz proc-
essor and built-in 1.7 GB hard disk drive (HDD) reduces waiting time for out-
put.

❖ Versatile Paper Handling Options
This printer offers the flexibility of selecting from a variety of paper handling
options.
The large input capacity, up to 3,550 sheets from six input sources, reduces
the inconvenience of reloading paper.
The output devices free users from manually collating, stapling or punching
documents.

❖ High Productivity
A high-speed engine combined with advanced paper handling features in-
creases the productivity of users who need to print several sets of multiple
page documents.
With the proof printing function, users can confirm that the output is correct
before several sets of documents are printed out.

❖ Network Connectivity
This printer is network capable with a built-in 100BASE-TX card.
It is easy to connect this printer to your network with utility.

❖ Crisp Print Image Quality
This printer supports PCL 6 as well as Adobe PostScript Level 3.
With a real 600dpi-resolution engine(plus smoothing technology), crisp im-
ages can be printed.
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❖ Major Specifications

Continuous Printing Speed 45 ppm (A4K, 8 1/2” × 11”K, simplex)

36 ppm (A4K, 8 1/2” × 11”K, duplex)

Engine Resolution 300 dpi, 400 dpi, 600 dpi

Printer Languages PCL 5e, PCL 6

Adobe PostScript Level 3 

Paper Input Capacity 500 sheets × 2 trays + 50 sheets bypass tray

Max. 3,550 sheets with options

Paper Output Capacity 500 sheets

Max. 4,900 sheets with options

Memory 8 MB

Expandable to 72 MB

HDD 1.7 GB

Interface 100BASE-TX × 1 

IEEE1284 × 1

Options PS430 (paper bank, 500–sheet × 2 trays)

Large Capacity Tray RT36 (1500–sheet Large 
Capacity Tray)

Finisher SR720 (1000–sheet finisher)

Finisher SR730 (3000–sheet finisher)

Mailbox CS360 (9-bin mailbox)

Hard Disk Drive Type 450 (1.6 GB HDD for 
font downloads)
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Printer Drivers for Your Printer

Printing requires installation of a printer driver for your operating system. The
following drivers are included in the CD-ROM that comes with this printer.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows for Workgroups operating system Version 3.11
*4 Microsoft Windows NT Server network operating system Version 4.0, Microsoft

Windows NT Workstation operating system Version 4.0 in a computer using a x86
processor.

*5 Required system is 7.1 or later operating system.
*6 Requires Service Pack 3 or later.
*7 Adobe PostScript Printer Driver and PostScript Printer Description (PPD) files are in-

cluded in the CD-ROM.

❖ PCL printer drivers
Printer drivers allow the computer to communicate with the printer using a
printer language. Two kinds of PCL printer drivers, PCL 6 and PCL 5e, are
included in the CD-ROM that comes with this printer. We recommend the
PCL 6 as your first choice. However, some of your applications might require
installation of the PCL 5e printer driver. In this case, you can install PCL 5e in
addition to the PCL 6.
⇒ P.51 “Windows 95/98 - Installing the PCL 6/5e Printer Driver”
⇒ P.52 “Windows 3.1x - Installing the PCL 6/5e Printer Driver”
⇒ P.53 “Windows NT 4.0 - Installing the PCL 6/5e Printer Driver”

❖ Adobe PostScript Printer Drivers and PPD files
Adobe PostScript printer drivers and the PPD files are included in the CD-
ROM that comes with this printer. Adobe PostScript printer driver allows the
computer to communicate with the printer using a printer language. The PPD
files allow the printer driver to enable the printer specific functions.
⇒ P.59 “Windows 95/98 - Installing the PostScript Printer Driver”
⇒ P.60 “Windows 3.1x - Installing the PostScript Printer Driver”
⇒ P.61 “Windows NT 4.0 - Installing the PostScript Printer Driver”
⇒ P.63 “Macintosh - Installing the PostScript Printer Driver”

Operating system

Printer Language PCL 5e PCL 6 PostScript 
3

Windows 95 *1 √ √ √

Windows 98 *2 √ √ √

Windows 3.1x *3 √ √ √

Windows NT 4.0 *4 √ √ √ *6  *7 

Macintosh *5 √ *7 
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Guide to the Printer

Exterior: Front View

1. Printer Board

Remove this board when installing some
options.

2. Network Cable Connector

Plug the network cable, which connects
the printer to the network, into this sock-
et.

3. Parallel Interface Connector

Plug the parallel cable that connects the
printer to your computer into this socket.

4. Power Switch

Use this switch to turn the printer power
on and off.

5. Output Tray

Printed output is stacked here with the
print side face down.

6. Operation Panel

Contains keys for printing operation and
a panel display that shows the printer
status. 

⇒ P.7 “Operation Panel”

7. Front Cover

Open this cover if you replace some parts
or if a paper misfeed occurs.

8. Paper Tray

Holds up to 500 sheets of plain paper. (80
g/m2, 20 lb)

9. Optional Paper Bank PS430

Holds up to 500 sheets of plain paper. (80
g/m2, 20 lb)

TAPH174E
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Exterior: Rear View

1. Duplex Unit

Allows you to print onto both sides of the
paper.

2. Duplex Unit Right Cover

Open this cover if you want to print onto
both sides of the paper larger than B4 JIS
and 81/2” × 14”.

3. Bypass Tray

Holds up to 50 sheets of  plain paper. (80
g/m2, 20 lb)

4. Upper Vertical Paper Feed Cover

Open this cover when accessing the in-
side of the printer.

If you install the optional Large Capacity
Tray RT36, remove this cover.

5. Lower Vertical Paper Feed Cover

Open this cover when accessing the in-
side of the printer.

6. Power Cord

Plug this cord into a wall outlet.

7. Ventilator

Helps to keep components inside the
printer from overheating.

TAPH182E
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Interior

1. Fusing Unit

When “Change Maint.Kit” appears on
the panel display, replace this unit.

2. Transfer Unit

When “Change Maint.Kit” appears on
the panel display, replace this unit.

3. Toner Lock Handle

Turn up the lever when replacing the
toner.

4. Toner Holder

Slide this out when replacing the toner.

5. Development Unit

When “Change Maint.Kit” appears on
the panel display, replace this unit.

6. Right Cover

Open this cover when accessing the in-
side of the printer.

TAPH191E

1 2

6543



Guide to the Printer

7

1

Operation Panel

1. Panel Display

Shows the current status of the printer
and error messages. ⇒ P.99 “Error & Sta-
tus Messages on the Operation Panel”

2. On Line indicator

Tells you whether the printer is online or
offline. 

Stays on while the printer is online (a
state in which the printer can receive data
from the computer). 

Stays off when the printer is offline (a
state in which the printer can not receive
data).

3. Power indicator

Stays on while the printer power is on.
Stays off when the power is turned off or
while the printer is in the Energy Saver
mode.

4. Error indicator

Lights up whenever any printer error oc-
curs. A message describing the cause of
the error also appears on the panel dis-
play. ⇒ P.99 “Error & Status Messages on
the Operation Panel”

5. Data In indicator

Blinks while the printer is receiving data
from a computer. 

Stays on if there is data to be printed.

TA

1

2
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Keys

1. {On Line} key

Press this key to switch the printer online
or offline. When the printer is online, the
printer can receive data from the compu-
ter.

2. {Job Reset} key

When the printer is online, press this key
to cancel any ongoing print jobs.

3. {Escape} key

Press this key to escape from the setup
menu, and to return to the upper level
without making any changes.

4. {U}{T} keys

Use these keys to scroll through the se-
lected items and to adjust values on the
panel display when making settings. To
change the value more quickly, hold
these keys down.

5. {Form Feed} key

When the printer is offline, press this key
to print out all the data left in the printer's
input buffer.

6. {Menu} key

Press this key to make and check the cur-
rent printer settings. To go back to the
[Main] menu, press this key again.

7. {Enter} key

Press this key to choose menu selected on
the panel display, or to go to a lower lev-
el.

TAP

1 2

65

43
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Guides

The guides of the output tray minimize curled printed output. Use these guides
when you print on A3L size paper, 11" × 17"L size paper, or thin paper.

❖ To print onto A3L and 11" × 17"L size paper
Raise the end fence.

❖ If either side of paper is curled, or if you print onto the thin paper

Raise the left end of the guide until it clicks.

TAPY510E

TAPX070E

TAPY520E
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❖ If the leading edge of paper is curled

A Remove the guide.

B Reinstall the guide in the opposite direction as shown in the illustration.

Note

❒ If you use the guides, output capacity is reduced.

TAPX060E

TAPY530E

TAPY540E
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2. Installing Options

R CAUTION:

See P.157 “Options”  to confirm what kind of options are available.

• Before installing options, the machine should be turned off and unplugged 
for at least thirty minutes. Components inside the machine become very 
hot, and can cause a burn injury if touched.

• Before moving the machine, unplug the power cord from the outlet. If the 
cord is unplugged abruptly, it could become damaged. Damaged plugs or 
cords can cause an electrical or fire hazard.

• When lifting the machine, use the grips on both sides. The machine could 
break or cause an injury if dropped.
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Available Options

The following options can be installed to your printer.

❖ Exterior

1. Paper Bank PS430

⇒ P.16 “Installing the Paper Bank
PS430”

2. Large Capacity Tray RT36

If you want to install the Large Capac-
ity Tray RT36, contact your sales or
service representative.

3. Bridge Unit Type 450

If you want to install the Bridge Unit
Type 450, contact your sales or service
representative.

4. Finisher SR720

If you want to install the Finisher
SR720, contact your sales or service
representative.

5. Finisher SR730

If you want to install the Finisher
SR730, contact your sales or service
representative.

6. Mailbox CS360

If you want to install the Mailbox
CS360, contact your sales or service
representative.

Note

❒ The Bridge Unit Type 460 is re-
quired when you install both the
Finisher SR730 and the Mailbox
CS360.

❒ To use the punch function with the
Finisher SR730, the Punch Kit Type
450 is required.

1

2

5

4

3

6

TAPP711E
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❖ Interior

1. Extended RAM Module

Install the memory unit into the slots
in the printer board.  ⇒ P.14 “Install-
ing the Memory Unit” 

2. Hard Disk Drive Type 450

Install the HDD into the slot in the
printer board.

Note

❒ When you install several different options, be sure to install the paper bank
PS430 first.

How to Use the Screwdriver

The screwdriver (A) is in the standard paper tray (Tray 1). It is used to install
options. To prevent the screw from falling down, press the screwdriver onto the
screw until it clicks into place.

TAPP731E

1. 2

TAPP760
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Installing the Memory Unit

R CAUTION:

8 MB, 16 MB, and 32 MB memory
units are available for this printer.
Use the following types of memory
unit. 

❖ Module Type: 
SIMM (Single In-Line Memory
Module)

❖ Memory Type: 
EDO (Extended Data Output)
DRAM

❖ Number of Pins: 
72 pins

❖ Access Time: 
Faster than 60 ns

Important

❒ The memory unit can be damaged
by small amounts of static electric-
ity. Before touching it, touch some
metal to remove static electricity
from you.

❒ This printer has two slots for
SIMMs.

❒ The memory unit using 64 bit
chips is not available.

A Be sure to turn off the printer.

B Pull out the first paper tray (Tray
1) and take the screwdriver (A)
from the tray. Each of the screws
that are to be removed requires
this screwdriver.

Note

❒ Be sure to return the screwdriv-
er to the paper tray after using
it.

C Remove the four screws, and then
remove the cover.

You need the screws to lock the
cover afterwards.

• Before installing options, the ma-
chine should be turned off and 
unplugged for at least thirty min-
utes. Components inside the 
machine become very hot, and 
can cause a burn injury if 
touched.

• Before moving the machine, un-
plug the power cord from the out-
let. If the cord is unplugged 
abruptly, it could become dam-
aged. Damaged plugs or cords 
can cause an electrical or fire 
hazard.

• When lifting the machine, use 
the grips on both sides. The ma-
chine could break or cause an in-
jury if dropped.

TAPP720E

TAPP550E
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D Remove the two screws locking
the printer board.

You need the screws to lock the
printer board afterwards.

E Hold the handle, and carefully
pull out the printer board.

F Confirm that the notch on the
memory unit is on the right as
shown in the illustration. Tilting
the memory unit with the notch
on the right, slide it into the slot
as shown in the illustration (A).
Then, move it upward until it
clicks into place (B). 

G Align the printer board with the
top and bottom rails in the print-
er, and then insert the printer
board slowly until it clicks into
place.

H Lock the printer board with the
two screws you removed in step
D.

I Return the cover to its original po-
sition with the four screws you re-
moved in step C.

Note

❒ Print a configuration page to
confirm that the memory unit is
properly installed. ⇒ P.144
“Printing the Test Page”

TAPP600E

TAPP610E

TAPP622E

TAPP630E

TAPP750E

TAPP590E
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Installing the Paper Bank PS430

R CAUTION: A Confirm that the printer is turned
off, and pull the plug out of the
wall outlet. 

B Remove the tape that holds the
paper bank, and remove the pack-
ing material.

Important

❒ Do not remove the tape that
holds the connector cable on the
backside of the paper bank in
this step. It is removed at step L.

• Before installing options, the ma-
chine should be turned off and 
unplugged for at least thirty min-
utes. Components inside the 
machine become very hot, and 
can cause a burn injury if 
touched.

• Before moving the machine, un-
plug the power cord from the out-
let. If the cord is unplugged 
abruptly, it could become dam-
aged. Damaged plugs or cords 
can cause an electrical or fire 
hazard.

• When lifting the machine, use 
the grips on both sides. The ma-
chine could break or cause an in-
jury if dropped.

TAPP801E

TAPP811E
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C Remove the screw, knob screw
and lock plate from inside the
packing material.

1. Screw

2. Knob Screw (Finger type)

3. Lock Plate

D Align the printer over the paper
bank, and then lower it gently
onto the paper bank.

Important

❒ When lifting the printer, pull
out the grips from the front side
of the printer. Hold the front
side grips, and hold the inset
grips on the rear side. 

❒ The printer should be held by at
least two people.

E Push the grips into the printer.
Take out the cover inside the Tray
2 and attach it between the paper
tray and the front cover.

F Pull the second paper tray (Tray 2)
up until it stops. After that, lift it
slightly, then pull it out.

G Pull out the first paper tray (Tray
1) , and take the screwdriver (A)
from the tray.

Note

❒ Be sure to return the screwdriv-
er to the paper tray after using
it.

1

2

3

TAPD011E
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H Lock the paper bank and the
printer with the screw.

I Replace the second paper tray
(Tray 2) into the printer.

J Open the lower vertical paper
feed cover on the right side of the
paper bank (A). Hang the lock
plate hook in the hole inside (B),
and then fasten the plate with the
knob screw using your fingers.

K Close the lower vertical paper
feed cover.

L Open the connector cover (A), re-
move the tape that holds the connec-
tor cable and attach the connector
cables (B) as shown in the illustra-
tion.

M Close the connector cover.

Note

❒ Print a configuration page to
confirm that the paper bank is
properly installed. If the paper
bank is properly installed. ⇒
P.144 “Printing the Test Page”

TAPP031E

TAPH221E

TAPP050E
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3. Configuring the Printer for
the Network

This section describes how to configure your printer for use as a network printer.
The actual procedures may differ depending on your network environment. Use
the appropriate procedures for your network environment. 

If you use TCP/IP protocol to print, the printer must also be configured to use
TCP/IP protocol. Follow the instructions in "Setting Up the IP Parameters" sec-
tion of this manual to configure your printer to use TCP/IP protocol. After that,
go to the section with instructions  for the type of network you use. 

If you use protocols other than TCP/IP, go to the section with instructions  for
the type of network you use. 

The network configuration page is automatically printed when the printer is
turned on. This feature can be disabled with the MAP utility or by connecting
the Network Interface Board address with a browser. To disable this feature,
open the [Network Setting] screen. Then click [Configure Status Page] and remove
the check mark from [Print Status Page on Startup].

The network configuration page contains the Network Interface Board status in-
formation. You need this information when you configure the printer for the net-
work. 

Reference

Netware ⇒ P.36 “NetWare Configuration”

Macintosh ⇒ P.48 “Macintosh Configuration”
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Setting Up the IP Parameters

Configuring the Printer for the 
Network with the Operation 
Panel

This section describes instructions on
configuring the printer for the net-
work using the printer's operation
panel. You can also set up the IP Pa-
rameters using the NIB Setup Tool.

⇒ P.24 “Installing the NIB Setup Tool”

A Press {Menu}.
The following message appears on
the panel display.

  Main Menu:      

   Proof Print   

B Press {T} or {U} until the follow-
ing message appears.

  Main Menu:     

   Host Interface

C Press {Enter}.
The following message appears on
the panel display.

  Host Interface:

   Printer Lang.

D Press {T} or {U} until the follow-
ing message appears.

  Host Interface:

   Network Setup

E Press {Enter}.
The following message appears on
the panel display.

  Network Setup: 

   I/O Timeout   

F Press {T} or {U} until the follow-
ing message appears.

  Network Setup:

   IP Address

G Press {Enter}.
Byte 1 of the current IP address ap-
pears on the panel display. 

  IP Address:     

        Byte 1=0

H  Use {U} or {T} to set the IP Ad-
dress.

  IP Address:     

        Byte 1=192

Note

❒ Press {UU} to increase and {TT}
to decrease values.

I Press {Enter}.
Byte 2 of the current IP address ap-
pears on the panel display.

  IP Address:     

        Byte 2=0

Note

❒ You can return to the previous
Byte by pressing {Escape}. 
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❒ If you press {Escape} when Byte
1 is on the panel display, the
new IP address is canceled and
you return to the previous panel
display.

J Repeat steps H and I to set the rest
of the IP address.

After setting Byte 4, the new IP Ad-
dress is displayed on the panel dis-
play for 2 seconds.

  IP Address:     

   192.168. 15. 16

The panel display returns to the
previous menu automatically.

The following message appears on
the panel display.

  Network Setup: 

   IP Address   

K Press {T} or {U} until the follow-
ing message appears.

  Network Setup: 

   Subnet Mask  

L Press {Enter}.
Byte 1 of the current subnet mask
appears on the panel display.

  Subnet Mask:    

        Byte 1=0

M Set the subnet mask using the
same procedure used to set the IP
address.

After setting Byte 4, the new sub-
net mask is displayed on the panel
display for 2 seconds.

  Subnet Mask:    

   255.255.255.  0

The panel display returns to the
previous menu automatically.

The following message appears on
the panel display.

  Network Setup:  

   Subnet Mask  

N Press {T} or {U} until the follow-
ing message appears.

  Network Setup:  

   Gateway Address  

O Press {Enter}.
Byte 1 of the current gateway ad-
dress is displayed on the panel dis-
play.

  Gateway Address 

        Byte 1=0  

P Set the gateway address using the
same procedure used to set the IP
address.

Q Press {On Line}.
After “Initializing...” is displayed
on the panel display, the panel dis-
play returns to the ready condi-
tion.

  Ready  
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Dynamic Host Configuration Protocol (DHCP)

The Dynamic Host Configuration Protocol (DHCP) provides a mechanism for
delivering IP configuration parameters, including the IP address, Subnet mask
and default gateway, to devices (hosts) on an IP network. A DHCP server man-
ages the pool of available IP addresses and grants device requests for an IP ad-
dress.

At power-up, the Network Interface Board broadcasts a DHCP request for an IP
address. If a DHCP server is present the request might be processed, and an IP
address might be returned to the Network Interface Board. Upon receipt of the
IP address, the Network Interface Board resets, and prints a network configura-
tion page. The network configuration page might list the new IP address (and
Subnet mask and default gateway). Once an IP address has been assigned to the
Network Interface Board, it might no longer broadcast DHCP requests.

Important

❒ Network Interface Board IP address assignment by DHCP works only if the
Network Interface Board does not have an existing IP address.

The DHCP server leases a temporary IP address which expires after a period, or
leases a permanent or unlimited lease which does not expire.

Devices that are granted a temporary lease are notified before the lease expires
and asked if they would like to extend the lease. The Network Interface Board
continues extending its lease indefinitely (unless prohibited by your DHCP
server configuration) and thus maintain a consistent IP address.

Important

❒ If the Network Interface Board is not turned on or is not connected to the net-
work during the period when the DHCP server is sending requests to extend
the lease, the lease will not be extended. The DHCP server might cancel the
lease and might assign the IP address to another device. Therefore, it is highly
recommended to explicitly reserve an IP address for the Network Interface
Board in your DHCP server configuration.

If you prefer not to use DHCP for IP address assignment, it can be disabled using
the NIB Setup Tool. The NIB Setup Tool allows you to use a Wizard or a Prop-
erty Sheet to configure the Network Interface Board. Use the Property Sheet to
disable this feature. After you select the Network Interface Board with the NIB
Setup Tool, click [Configure] and then click the [TCP/IP] tab. If you prefer not to
use DHCP, select [Specify an IP Address] and set the IP address, the subnet mask
and the default gateway address.
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Getting Ready for Software Installation

This printer comes with two CD-ROMs. One is "Print Server Software and Doc-
umentation", and the other is "Printer Drivers and Utilities". These CD-ROMs
contain support programs for the installation and configuration of Network In-
terface Board.

You can select any of the programs listed in the Configuration Programs.

Configuration Programs

The "Print Server Software and Documentation" CD-ROM includes the follow-
ing utilities.

❖ MAP
Web-based configuration utility

❖ IPX Peer-to-Peer
IPX Peer-to-Peer printing software

❖ IP Peer-to-Peer
IP Peer-to-Peer printing software

❖ BootP Lite
Used to configure the IP parameters of the Network Interface Board

❖ NWSetup
NetWare Print Service Configuration

The five utilities are included in the “Print Server Software and Documentation”
CD-ROM, but you need this CD-ROM only if you use “IPX Peer-to-Peer” or “IP
Peer-to-Peer” printing.

Although you can use the "MAP", "BootP Lite", or "NWSetup" utilities in the
"Print Server Software and Documentation" CD-ROM, it is easier to use the NIB
Setup Tool included in the "Printer Drivers and Utilities" CD-ROM.

To use “MAP”, “BootP Lite”, or “NWSetup” from the “Print Server Software
and Documentation” CD-ROM, see the “Owner's Manual” (NIB 450-E Manual)
in this CD-ROM for instructions.
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Installing the NIB Setup Tool

This section describes how to install the PRINTER MANAGER FOR ADMINIS-
TRATOR, and how to run the NIB Setup Tool.

Limitation

❒ The NIB Setup Tool is supported to work with the following operation sys-
tems.

• Microsoft Windows 95/98

• Microsoft Windows NT 4.0

Installing the PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install the PRINTER MANAGER FOR ADMINISTRATOR.

Preparation

You should install the PRINTER MANAGER FOR ADMINISTRATOR on
your computer. If you install the PRINTER MANAGER FOR ADMINISTRA-
TOR from a file server or run it via the network, the PRINTER MANAGER
FOR ADMINISTRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into your com-
puter's CD-ROM drive.

If the setup menu starts automatically, follow the instructions on the screen.

Otherwise, continue to step C.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D In the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F In the [command line for installation program] box, type the name of the CD-
ROM drive followed by “PRINTMAN\ADMIN\SETUP.EXE” (do not in-
clude the quotation marks) and then click [Finish].

Note

❒ An example would be “D:\PRINTMAN\ADMIN\SETUP.EXE” when the
CD-ROM drive name is “D”.

G From the [Choose Setup Language] pop-up menu, select the language you use.

H In the [Welcome] dialog box, click [Next >].
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I The Software License Agreement appears. 

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.

J Select a folder to install it in, and then click [Next >].

If you would like to change the displayed folder, click [Browse] to select an-
other one.

The installation program starts.

After a confirmation dialog box appears, the installation program is complete.

Running the NIB Setup Tool

A Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.
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Windows 95/98 Configuration

Setting Up Peer-to-Peer Printing

The peer-to-peer printing software that is included in the CD-ROM labeled
“Print Server Software and Documentation” allows Windows 95/98 PCs to com-
municate directly with network attached printers. A network server, such as
NetWare or Windows NT, is not required for peer-to-peer printing.

There are two types of peer-to-peer printing. You can select “IP Peer-to-Peer” or
“IPX Peer-to-Peer” according to your network environment.

The peer-to-peer printing software must be installed on each PC that uses peer-
to-peer printing. Once peer-to-peer printing software is installed, all Network
Interface Boards on the network automatically appear in the list of available
printer ports.

The peer-to-peer printing software can also be used in networks where servers
are present; however, the server print services are often utilized instead. Server
based print services offer centralized printing management and spooling and do
not require software (other than the printer driver) to be installed on each PC.

If you use the printer in a network where servers are present, select either peer-
to-peer printing or the server based print service.

Reference

For information on setting IP parameters, see P.20 “Setting Up the IP Parame-
ters”.

Installing IP Peer-to-Peer

The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that the
TCP/IP protocol is installed, if not, install it before starting the following proce-
dure.

Follow these steps to install IP Peer-to-Peer.

Important

❒ Confirm that the printer power is turned on before starting the following pro-
cedure.

A Insert the CD-ROM labeled “Print Server Software and Documentation” in
the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader 3.0 is not installed, click [Install Adobe Acrobat
Reader 3.0].
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B Click [CD ROM Contents].

The “Introduction” page appears.

C Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

D Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].

The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears. 

This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.

F Click [Yes] to continue.

The [Welcome] dialog box appears.

G Click [Next] to continue.

The [Installation Notes] dialog box appears. 

H Click [Yes] to continue installation.

The [Choose Destination Directory] dialog box appears. 

I Click [Browse] to set a different folder. 

The default installation folder is C:\PROGRAM FILES\IP-P2P. 

J Click [Next] to continue.

The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

K Type the name that you wish to see in “Program Folder:” and click [Next].

The files are then copied to your computer in the specified directories.

The [Information] dialog box appears. 

L Click [OK] to complete the installation.

Reference

For more information on installing IP Peer-to-Peer, see “Owner's Manual”
(NIB 450-E Manual) in the CD-ROM labeled “Print Server Software and
Documentation”.
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-For manual installation

Follow these steps to install the software on your operating system (Windows
95/98).

A Insert the CD-ROM in the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the task bar, and click [Run]. 

D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to F- K in the preceding procedure. ⇒ P.26 “In-
stalling IP Peer-to-Peer”

Installing IPX Peer-to-Peer

The IPX protocol is required for IPX Peer-to-Peer printing. Confirm that the IPX
protocol is installed, if not, install it before starting the following procedure.

Follow these steps to install IPX Peer-to-Peer.

A Insert the CD-ROM labeled “Print Server Software and Documentation” in
the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader 3.0 is not installed, click [Install Adobe Acrobat
Reader 3.0].

B Click [CD ROM Contents].

The “Introduction” page appears.

C Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

D Click [Windows 95/98 & NT 4.x IPX Peer-to-Peer Printing].

The “Windows 95 and NT 4.x IPX Peer-to-Peer Printing” page appears. 

This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.
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F Click [Yes] to continue.

The [Welcome] dialog box appears.

G Click [Next] to continue.

The [Installation Notes] dialog box appears.

H  Click [Yes] to continue installation.

The files are then copied to your computer in the specified directories.

The [Installation Complete] dialog box appears. 

I Click [Finish] to complete the installation.

-For manual installation

Follow these steps to install the software on your operating system (Windows
95/98).

A Insert the CD-ROM in the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the task bar, and click [Run]. 

D Type <Drive>:\IPX-P2P\SETUP.EXE (where <Drive> is your CD-ROM
drive name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to F - H in the preceding procedure. ⇒ P.28 “In-
stalling IPX Peer-to-Peer”

Selecting the Printer Port

The peer-to-peer printing software should be installed on each Windows 95/98
PC that will use peer-to-peer printing services.

A Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

Important

❒ If you use IPX Peer-to-Peer printing, confirm that the printer power is
turned on before continuing the following steps.

Reference

For more information on the printer drivers, see P.51 “Installing the PCL 6/
5e Printer Driver” or P.59 “Installing the PostScript Printer Driver”.
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B Click [Start] on the task bar, point to [Settings], and then click [Printers]. 

The [Printers] window appears.

C Click the icon of the printer you want to set for the peer-to-peer printing.

D On the [File] menu, click [Properties].

The Printer Properties appears.

E Click the [Details] tab.

F From the [Print to the following port:] list box, select the port of the printer you
want to use for peer-to-peer printing.

• If you use IP Peer-to-Peer printing, select the IP address of the printer. If
you do not find the IP address of the printer, the printer is not in your local
subnet. Then you need to configure IP Peer-to-Peer port manually as de-
scribed in the “Owner's Manual” (NIB 450-E Manual) in the CD-ROM la-
beled “Print Server Software and Documentation”.

• If you use IPX Peer-to-Peer printing, select the printer name. The printer
name is shown in "Peer-to-Peer Connection Information" on the network
configuration page. The factory default of the printer name is RDP_ fol-
lowed by the 6 digit serial number.

G Click [OK].
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Windows NT 4.0 Configuration

Windows NT 4.0 Configuration

There are several options for setting up printing in a Windows NT environment.

• If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.

• Peer-to-peer print services can be used by following the instructions in this
section.

• LPR print services can be used via TCP/IP by following the instructions in
this section.

Windows NT printing is very flexible. It is possible to configure the individual
Windows NT or Windows 95/98 workstations to print using a different protocol
than the Windows NT server. For example, a Windows NT server could be con-
figured to print to a Network Interface Board via TCP/IP using the instructions
in this section. The Network Interface Board could then be designated as shared
on the NT server, allowing workstations to print via the NT server using a dif-
ferent protocol (such as NetBEUI).

The optimum Windows NT printing configuration depends upon the particular
environment and user as well as administrator experience and preferences. Gen-
erally, the LPR printing over TCP/IP covered in the following instructions is the
best choice for environments where TCP/IP is already in use.

If you do peer-to-peer printing in the Windows NT environments, it is strongly
recommended that you use TCP/IP Peer-to-Peer Software.

Setting Up Peer-to-Peer Printing

The peer-to-peer printing software that is included with the Network Interface
Board allows Windows NT 4.0 PCs to communicate directly with network at-
tached printers. A network server, such as NetWare or Windows NT, is not re-
quired for peer-to-peer printing.

The peer-to-peer printing software must be installed on each PC that might use
peer-to-peer printing. Once peer-to-peer printing software is installed, all Net-
work Interface Boards on the network automatically appear in the list of availa-
ble printer ports.

The peer-to-peer printing software can also be used in networks where servers
are present; however, often the server print services are utilized instead. Server
based print services offer centralized printing management and spooling and do
not require software (other than the printer driver) to be installed on each PC.

Reference

For information on setting IP parameters, see P.20 “Configuring the Printer for
the Network with the Operation Panel”.
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Installing IP Peer-to-Peer

The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that the
TCP/IP protocol is installed, if not, install it before starting the following proce-
dure.

Follow these steps to install IP Peer-to-Peer.

Important

❒ Confirm that the printer power is turned on before starting the following pro-
cedure.

A Insert the CD-ROM labeled “Print Server Software and Documentation” in
the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader 3.0 is not installed, click [Install Adobe Acrobat
Reader 3.0].

B Click [CD ROM Contents].

The “Introduction” page appears.

C Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

D Click [Windows 95/98 & NT 4.x IP Peer-to-Peer Printing].

The “Windows 95/98 and NT 4.x IP Peer-to-Peer Printing” page appears. 

This screen describes the functions of this utility. 

E At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.

F Click [Yes] to continue.

The [Welcome] dialog box appears.

G Click [Next] to continue.

The [Installation Notes] dialog box appears. 

H Click [Yes] to continue installation.

The [Choose Destination Directory] dialog box appears. 

I Click [Browse] to set a different folder. 

The default installation folder is C:\PROGRAM FILES\IP-P2P. 

J Click [Next] to continue.

The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.
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K Type the name that you wish to see in the Program Folder and click [Next].

The files are then copied to your computer in the specified directories.

The [Information] dialog box appears. 

L Click [OK] to complete the installation.

-For manual installation

Follow these steps to install the software on your operating system (Windows
NT 4.0).

A Insert the CD-ROM in the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the task bar, and click [Run]. 

D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to F- K in the preceding procedure. ⇒ P.32 “In-
stalling IP Peer-to-Peer”

Selecting the Printer Port 

The IP Peer-to- Peer printing software should be installed on each Windows NT
4.0 PC that uses peer-to-peer printing services.

Important

❒ The IP Peer-to-Peer printing software must be installed before selecting the
printer port.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled "Printer Drivers and Utilities" in the CD-ROM
drive.

If the setup menu starts automatically, you can proceed to the next step. If not,
see P.51 “Installing the PCL 6/5e Printer Driver” to start the installation and
then proceed to the next step.

C The [Printer Installation] dialog box appears.

D From the [Port] list, select the IP address of the printer you want to set up,
and click [Next >].

E Follow the instructions on the screen to finish the installation of the printer
driver.
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Setting Up LPR Printing

Follow these steps to set up LPR printing.

Note

❒ In the following instructions, some field or dialog box names might vary de-
pending on the NT service pack in use.

A  Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For information on setting IP parameters, see P.20 “Setting Up the IP Param-
eters”. 

B Click [Start] on the task bar, point to [Settings], and then click [Control Panel].

C Double-click [Network] and select the [Protocols] tab to confirm that the TCP/
IP protocol is installed.

If TCP/IP protocol is not in the list of Network Protocols, click [Add] to install
it.

D Select the [Services] tab.

If Microsoft TCP/IP Printing is not on the list of Network Services, click [Add]
to install it.

E Click [Close] when all protocols and services have been added.

If the TCP/IP protocol has just been added, set the IP address and other TCP/
IP parameters.

The new protocols and services will be available after the system is restarted.

Important

❒ If the printer driver has not already been installed, install it before contin-
uing.

F Click [Start] on the task bar, point to [Settings], and then click [Printers].

G Right click the appropriate printer and select [Properties].

H On the [Ports] tab, click [Add Port].

I Double-click [LPR Port] in the list of available printer ports.

J In the [Name or address of server providing lpd:] field, type the IP address of the
Network Interface Board (that was assigned with the operation panel).

K In the [Name of printer or print queue on that server:] field, type “PORT1” (quo-
tation marks are not included) in capital letters and click [OK].
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L Click [Close] to close the [Printer Ports] dialog box.

The Network Interface Board IP address is now displayed and currently se-
lected on the list of ports.

M If the printer is to be shared, click the [Sharing] tab, select Shared and type
the Share name.

N Click [OK] when finished.
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NetWare Configuration

Quick Setup Using the NIB Setup Tool Wizard

Using the NIB Setup Tool, you can easily set up a NetWare printing environ-
ment. 

Reference

For more information on setting up the NIB Setup Tool, see P.24 “Installing the
NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see P.38 “NetWare 3.x - Advanced
Settings” and P.41 “NetWare 4.x - Advanced Settings”.

Note

❒ This section assumes that NetWare is functional and that the necessary envi-
ronment for the NetWare Print Services is available.

❒ If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

• Windows 95/98 in NDS mode configuration

• Windows NT 4.0 in NDS mode configuration

• Windows NT 4.0 in Bindary mode configuration

A Log in to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.25 “Running the NIB Setup Tool”

C Click [Wizard] and click [OK].

The [Network board list] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Select the IPX address of the Network Interface Board you are configuring
by clicking it, and click [Next >].

Note

❒ If you don't know which Network Interface Board you are configuring,
print a network configuration page to confirm the MAC address (Network
address).
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F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

G Type the print server name into the [Device Name] box, and click [Next >].

The factory default is RDP_ followed by the 6 digit serial number. We recom-
mend that you change it to something that is easier to remember or something
based on the structure of your network.

H In a dialog box for selecting a network environment, check a box for [Net-
Ware] and remove the check mark for the [TCP/IP].

I Click [Next >].

A dialog box for configuring the NetWare environment appears.

J Select [Bindery] when printing under the Bindery mode, or select [NDS]
when printing under the NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

K If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

L If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among those
listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

M Click [Next >].

N Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The factory default for Printer Name is “Print Server Name” followed by “_1”
and that for Print Queue Name is “Print Server Name” followed by “_Q” (
quotation marks are not included). You can change them if necessary.
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O If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box. 

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

P Click [Next >].

A dialog box to confirm the printing environment appears.

Q After confirming the environment, click [Next >].

If you want to change the settings, click [< Back] and make the settings again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

R After a confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.

NetWare 3.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 3.x environment.

Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. For more information, see P.36 “Quick Setup Using the NIB Setup Tool
Wizard”.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Basic Procedure

Installing the NIB Setup Tool

Configuring the Network Interface Board

Configuring the NetWare

Turning the power off and on
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Setting Up as Print Server

A Log in to the file server as a Supervisor or a Supervisor equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.25 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Select the IPX address of the Network Interface Board which is to be con-
figured by clicking it, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.

I Click the [NetWare] tab, and make the following settings.

A Select [Bindery].

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K Type “PCONSOLE” from the command prompt.

F:> PCONSOLE



Configuring the Printer for the Network

40

3

L Create a print queue as follows.

Note

❒ If you use a currently defined print queue, proceed to the step M.

A From the [Available Options] menu, select [Print Queue Information] and press
{ENTER}.

B Press the {INSERT} key and type a print queue name.

C Press the {ESC} key to return to the [Available Options] menu.

M Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
{ENTER}.

B To create a new print server, press the {INSERT} key and type a print
server name.

If you use an currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important

❒ Use the same name as that specified in the NIB Setup Tool. ( Step H).

C From the [Print Server Information] menu, select the [Print Server Configura-
tion].

D From the [Print Server Configuration menu], select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

F If you change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. “x” stands for the number of
the selected printer.

G As Type, select [Remote Other/Unkown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {ESC} key, and click [Yes] in the confirmation dialog box.

I Press the {ESC} key to return to the [Print Server Configuration] menu.

N Assign print queues to the created printer as follows.

A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step M.

C Press the {INSERT} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, confirm that the queues are as-
signed.
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O Press the {ESC} key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

P Turn the printer power off and on.

Note

❒ To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.

NetWare 4.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 4.x environment.

Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. For more information, see P.36 “Quick Setup Using the NIB Setup Tool
Wizard”.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

❒ You should install the client software released from Novell on the Windows
before running the NIB Setup Tool for configuring in NDS mode or using
Windows NT 4.0.

Basic Procedure

Installing the NIB Setup Tool

Configuring the Network Interface Board

Configuring the NetWare

Turning the power off and on
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Setting Up as Print Server

Important

❒ You can set up the print server using the NDS or Bindery mode in NetWare
4.x. The following procedure is for setting up the print server using the NDS
mode in NetWare 4.1. When you set up the print server using the Bindery
mode, use the NIB Setup Tool Wizard. ⇒ P.36 “Quick Setup Using the NIB Set-
up Tool Wizard”.

A Log in to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.25 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Select the IPX address of the Network Interface Board which is to be con-
figured by clicking it, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see the network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.

I Click the [NetWare] tab, and make the following settings.

A Select [NDS].
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B Type into the [Tree:] box the name of the NDS tree in which the print
server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS"

C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K From Windows, run NWAdmin.

Reference

For more information on NWAdmin, see the documentation that comes
with the NetWare.

L Create a print queue as follows.

A Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue” to highlight it, and
click [OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click the [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created to highlight it, and click [OK].

F After confirming the settings, click [Create].

M Create a printer as follows.

A Select the container object the printer is located in, and click [Create] on
the [Object] menu.

B In the [Class of new object] box, click “Printer” to highlight it, and click
[OK].

C In the [Printer name] box, type the name of the printer.

D Click [Define additional properties] to check a box, and click [Create].
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N Assign print queues to the created printer as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step L to highlight
it, and click [OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
dropdown menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and click [OK].

E After confirming the settings, click [OK].

O Create a print server as follows.

A Select the context specified using the NIB Setup Tool (step I-A), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server” to highlight it, and
click [OK].

C In the [Print Server name] box, type the name of the print server.

Important

❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Click [Define additional properties] to check a box, and click [Create].

P Assign the printer to the created print server as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the printer created in step M to high-
light it, and click [OK].

C After confirming the settings, click [OK].

Q Turn the printer power off and on.

Note

❒ If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up a Client Computer

This section describes how to set up a client computer when you use a NetWare
print server.

Note

❒ This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setup procedure.
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Windows 95/98

Follow these steps to set up a Windows 95/98 client. 

Preparation

Log in to the NetWare file server before starting the following procedure.

A Install the printer driver of the printer you want to use as “Local printer”.

Reference

For more information on installing the printer driver, see P.51 “Installing
the PCL 6/5e Printer Driver” and P.59 “Installing the PostScript Printer Driv-
er”.

Note

❒ Any port is selected during the installation, however, LPT1 is recommend-
ed.

B Click [Start], point to [Settings], and then click [Printers].

C In the [Printers] window, click the icon of the printer you want to use. 

D On the [File] menu, click [Properties].

E Click the [Details] tab, and click [Add Port].

F Click [Network] and click [Browse].

G On the network tree, double-click the name of the file server.

The queues are displayed.

H Click the queue you want to print to highlight it, and click [OK].

I Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

J Click [OK] to close the printer's property, and again, open it.

K Click the [Printer Settings] tab.

L Remove the check marks from the [Form feed] and the [Enable banner] check
boxes.

Note

❒ You should not check these boxes, because they should be specified using
the printer driver. If they are checked, the printer might not print correctly.
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When Using the PostScript Printer Driver

Follow these steps to set up for the PostScript Printer Driver

A Click the [PostScript] tab. 

B Click [Advanced].

C Remove the check marks from the [Send CTRL+D before job] and the [Send
CTRL+D after job] check boxes.

M Click [OK] to close the property.

Windows 3.1x

Follow these steps to set up a Windows 3.1x client. 

Note

❒ This section assumes that the client software released from Novell is installed
on the client computer.

A Install the printer driver of the printer you want to use as “Local printer”.

Reference

For more information on installing the printer driver, see P.51 “Installing
the PCL 6/5e Printer Driver” and P.59 “Installing the PostScript Printer Driv-
er”.

B Double-click the [Printers] icon on [Control Panel].

C In the [Installed Printers] box, select the printer driver you want to use by
clicking it, and then, click [Connect].

D In the [Ports] box, click “LPT1” to highlight it, and click [Network].

The [NetWare Printer Connections] dialog box appears.

E In the [Ports] box, click “LPT1” to highlight it, and in the [Resources]box,
click the queue you want to print to highlight it.

Note

❒ You should log in to the file server in order to see the print queues.

F Click [Capture].

The specified queue is captured to the LPT1.

G Click [LPT Settings].

The [NetWare Settings] dialog box appears.
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H Remove the check marks from the [Form Feed] and the [Enable Banner] check
boxes.

Note

❒ You should not check these boxes, because they should be specified using
the printer driver. If they are checked, the printer might not print correctly.

I Click [OK] to close the [NetWare Settings] dialog box.

J Close the [Network driver] dialog box.

K Click [OK] to close the [Connect] dialog box.

L Click [Close] to close the [Printers] dialog box.

Windows NT 4.0

Follow these steps to set up a Windows NT 4.0 client.

Preparation

Log in to the NetWare file server before starting the following procedure.

A Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM labeled "Printer Drivers and Utilities" in the CD-ROM
drive.

If the setup menu starts automatically, you can proceed to the next step. If not,
see P.51 “Installing the PCL 6/5e Printer Driver” and P.59 “Installing the Post-
Script Printer Driver” to start the installation and then proceed to the next step.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step A, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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Macintosh Configuration

Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh are slightly different depending
on the version of the Mac OS. If you are not using Mac OS 8, see the manual that
comes with your version of the Mac OS for more information.

Reference

For information on configuring a network printer in a Macintosh EtherTalk
environment, see “PostScript 3 Operating Instructions Supplement” included
in the CD-ROM labeled “Printer Drivers and Utilities”.

Changing to EtherTalk

Reference

For information on installing the software required for EtherTalk, see the
Macintosh manuals.

A Open [Control Panels], and double-click the [AppleTalk] icon.

B Select [Ethernet] from the [Connect via:] pop-up menu.

C If you change zones, select a name from the [Current zone:] pop-up menu.

D Close the [AppleTalk] control panels.

E Restart the Macintosh.
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UNIX Configuration

UNIX Configuration 

UNIX printing utilizes a line printer daemon (lpd) to direct jobs to the printer.
With printer-based lpd, the Network Interface Board acts as the line printer dae-
mon host and accepts print jobs directly. 

TCP/IP configuration of the Network Interface Board is needed for all versions
of UNIX. See “Owner's Manual” (NIB 450-E Manual) in the CD-ROM labeled
“Print Server Software and Documentation” for lpd configuration.

Note

❒ Be sure to turn the printer off and on after changing the network configura-
tion.
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4. Installing the PCL 6/5e
Printer Driver

Installing the PCL 6/5e Printer Driver

Printing requires installation of a printer driver for your operating system.

This section describes instructions for installing the printer driver. The actual
procedure differs somewhat depending on your operating system.

This printer comes with two kinds of PCL printer drivers. One is PCL 6, and the
other is PCL 5e.

Generally, we recommend PCL 6 as your first choice, for it provides better
WYSIWYG (What You See Is What You Get) and higher speed than PCL 5e.

However, some of your application software might require the installation of the
PCL 5e printer driver. In this case, you can install the PCL 5e printer driver in
addition to the PCL 6 printer driver.

Follow the appropriate one of the following procedures.

Important

❒ Before starting this installation, close all documents and applications. In a net-
work environment, confirm that users who are logged on are disconnected.
Be sure to do this when it will create the least interference with other users.

❒ After installing a printer driver, you must restart the computer.

❒ Never have two versions of the same printer driver installed on your system
at the same time. When upgrading to a new version of the printer driver, un-
install the old version, and then install the new one.

Windows 95/98 - Installing the PCL 6/5e Printer Driver

Installing the printer driver

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue the step C.

C Click [Start] on the task bar.

D Click [Run].

E In the [Run] window, click [Browse].
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F Select the CD-ROM drive.

G Open [PCL6 (or PCL5E)].

H Open [WIN31_95].

I Open the folder of the language you use.

J Open [DISK1].

K Open the file titled “Setup.exe”.

L Click [OK].

M Follow the instructions on the screen.

Setting up options

Note

❒ When setting up options, you should access the Printer Properties from Win-
dows. You cannot access the Printer Properties from an application.

A Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

B Select the icon of the printer you want to use by clicking it. On the [File]
menu, click [Properties].

C Click the [Accessories] tab. 

D Select any options you have installed from the [Options] group.

E Click [OK] .

Windows 3.1x - Installing the PCL 6/5e Printer Driver

Installing the printer driver

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

C From [Program Manager], click [Run] on the [File] menu.

D In the [Run] window, click [Browse].

E Select the CD-ROM drive from the [Drives:] list.
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F Open [PCL6 (or PCL5E)].

G Open [WIN31_95].

H Open the folder of the language you use.

I Open [DISK1].

J Open the file titled ”Setup.exe”.

K Click [OK].

L Follow the instructions on the screen.

Setting up options

Note

❒ When setting up options, you should access the Printer Setting dialog box
from Windows. You cannot access the Printer Setting dialog box  from an ap-
plication.

A From the [Main] group of [Program Manager], open [Control Panel] by double-
clicking it.

B Double-click the [Printers] icon.

C In the [Installed Printers:] list box, click the name of the printer you want to
set up.

D Click [Setup].

E Click [Accessories] tab. The [Options] group appears.

F Select any options you have installed from the [Option] group.

G Click [OK] to close the Printer Setting dialog box.

H Click [Close] to close the [Printers] dialog box.

Windows NT 4.0 - Installing the PCL 6/5e Printer Driver

Installing the printer driver

Limitation

❒ Installing a printer driver requires Full Control access permission. Members
of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default.
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A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue to step C.

C Click [Start] on the task bar.

D Click [Run].

E In the [Run] window, click [Browse]. 

F Select the CD-ROM drive.

G Open [PCL6 (or PCL5E)].

H Open [NT4].

I Open the folder of the language you use.

J Open [DISK1].

K Open the file titled ”Setup.exe”.

L Click [OK].

M Follow the instructions on the screen.

-Sharing the Printer on Windows NT 4.0 for Windows 95/98 Client

A Install the Windows NT 4.0 printer driver on Windows NT 4.0 following the
previous procedure.

B Install the Windows 95/98 printer driver on Windows NT 4.0 as an Alternate
driver from the following folders in the CD-ROM:

• PCL 5e
\PCL5E\WIN31_95\(language)\DISK1

• PCL 6
\PCL6\WIN31_95\(language)\DISK1

Important

❒ Be sure to select the same printer language and printer model as used in
the version of Windows NT 4.0 you have installed.

C After installing the Windows 95/98 printer driver, open the Printer Proper-
ties and confirm that the Windows 95/98 driver has been installed as an Al-
ternate driver on the [Sharing] tab.
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Setting up options

Limitation

❒ Changing the settings of the printer requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default.

Note

❒ When setting up options, you should access the Printer Properties from Win-
dows. You cannot access the Printer Properties from an application.

A Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

B Select the icon of the printer you want to use by clicking it. On the [File]
menu, click [Properties].

C Click the [Accessories] tab. 

D Select any options you have installed from the [Options] group.

E Click [OK] .
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Uninstalling the PCL 6/5e Printer Driver

This section describes instructions for uninstalling the printer driver. The actual
procedure differs somewhat depending on your operating system.

Follow the appropriate one of the following procedures.

Windows 95/98 - Uninstalling the PCL 6/5e Printer Driver

A Close all the applications that are currently running. 

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue to step C.

C Click [Start] on the task bar.

D Click [Run].

E In the [Run] window, click [Browse]. 

F Select the CD-ROM drive.

G Open [PCL6 (or PCL5E)].

H Open [WIN31_95]. 

I Open the folder of the language you use.

J Open [DISK1].

K Open the file titled ”Unsetup.exe”.

L Click [OK].

M Follow the instructions on the screen.

Windows 3.1x - Uninstalling the PCL 6/5e Printer Driver

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

C From [Program Manager], click [Run] on the [File] menu.

D In the [Run] window, click [Browse].
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E Select the CD-ROM drive from the [Drives:] list box.

F Open [PCL6 (or PCL5E)].

G Open [WIN31_95].

H Open the folder of the language you use. 

I Open [DISK1].

J Open the file titled “Unsetup.exe”.

K Click [OK].

L Follow the instructions on the screen.

Windows NT 4.0 - Uninstalling the PCL 6/5e Printer Driver

Limitation

❒ Uninstalling a printer driver requires Full Control access permission. Mem-
bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control permission by default.

A Close all the applications that are currently running. 

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue to step C.

C Click [Start] on the task bar.

D Click [Run].

E In the [Run] window, click [Browse].

F Select the CD-ROM drive.

G Open [PCL6 (or PCL5E)].

H Open [NT4]. 

I Open the folder of the language you use.

J Open [DISK1].

K Open the file titled “Unsetup.exe”.

L Click [OK]. 

M Follow the instructions on the screen.
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5. Installing the PostScript
Printer Driver

Installing the PostScript Printer Driver 

Printing requires installation of a printer driver for your operating system.

This section describes instructions for installing the printer driver. The actual
procedure differs somewhat depending on your operating system.

Follow the appropriate one of the following procedures.

Windows 95/98 - Installing the PostScript Printer Driver

Installing the printer driver

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue to step C.

C Click [Start] on the task bar.

D Click [Run].

E  In the [Run] window, click [Browse].

F Select the CD-ROM drive.

G Open [PS].  

H Open [WIN95_98]. 

I Open the folder of the language you use.

J Open [DISK1].

K Open the file titled “Setup.exe”.

L Click [OK].

M Follow the instructions on the screen.
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Setting up options

Note

❒ When setting up options, you should access the [Device Options] tab from Win-
dows. You cannot set up options when accessing the [Device Options] tab from
an application

A Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

B Select the icon of the printer you want to use by clicking it. On the [File]
menu, click [Properties].

C Click the [Device Options] tab.

The [Installable options] group appears.

D From the [Installable options] box, select the option you have installed. 

The current setting is displayed in the [Change settings for:] list box.

E Use the [Change settings for:] list box to select the appropriate setting for the
selected option.

F Click [Apply] to apply the settings you made.

G After making all settings you want, click [OK].

Windows 3.1x - Installing the PostScript Printer Driver

Installing the printer driver

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

C From [Program Manager], click [Run] on the [File] menu.

D In the [Run] window, click [Browse].

E Select the CD-ROM drive in the [Drives:] list.

F Open [PS].

G Open [WIN31].

H Open the folder of the language you use.
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I Open [DISK1].

J Open the file titled “Setup.exe”.

K Click [OK].

L Follow the instructions on the screen.

Setting up options

A From the [Main] group of [Program Manager], open [Control Panel] by double-
clicking it.

B Double-click the [Printers] icon.

C In the [Installed Printers:] list box, click the name of the printer you want to
set up.

D Click [Setup].

E Click the [Features] tab. 

The [Printer Features] group appears.

F Use the [Printer Features] group to specify the options.

G Click [OK] to close the Printer Setting dialog box.

H Click [Close] to close the [Printers] dialog box.

Windows NT 4.0 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation

❒ Installing a printer driver requires Full Control access permission. Members
of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue to step C.

C Click [Start] on the task bar.
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D Click [Run].

E In the [Run] window, click [Browse].

F Select the CD-ROM drive. 

G Open [PS].

H Open [NT4].

I Open the folder of the language you use.

J Open [DISK1].

K Open the file titled “Setup.exe”.

L Click [OK].

M Follow the instructions on the screen.

Setting up options

Limitation

❒ Changing the settings of the printer requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default.

Note

❒ When setting up options, you should access the Printer Properties from Win-
dows. You cannot set up options when accessing the Printer Properties from
an application

A Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

B Select the icon of the printer you want to use by clicking it. On the [File]
menu, click [Properties].

C Click the [Device Settings] tab.

D Use the [Installable Options] group to specify the options.

E Click [OK] to close the Printer Properties.



Installing the PostScript Printer Driver

63

5

Using the Adobe PageMaker Version 6.0 or 6.5

If you use the printer under Windows 95/98/3.1x/NT 4.0 with Adobe Page-
Maker, you need to copy the PPD file to the PageMaker folder.

The PPD file is the file with extension ".ppd". It is in the folder "\PS\NT4\ENG-
LISH\DISK1\" on the CD-ROM labeled “Printer Drivers and Utilities”.

The [NT4] folder, inside the [PS] folder is for the Windows NT 4.0 operating sys-
tem. Use the folder at this level that is appropriate for the operating system you
are using.

The [ENGLISH] folder, inside the [NT4] folder is for English. Use the folder at this
level that is appropriate for the language you use.

Copy this file to the PageMaker's folder.

For PageMaker 6 default installation, the folder is "C:\PM6\RSRC\PPD4", and
for PageMaker 6.5 default installation, the folder is "C:\PM6\RSRC\USENG-
LISH\PPD4".  The "USENGLISH" might be different, depending on your lan-
guage selection.

Macintosh - Installing the PostScript Printer Driver

Installing the Printer Driver

It is necessary to install a printer driver and a PPD file to print from a Macintosh.

Follow these steps to install a printer driver and a PPD file into a Macintosh us-
ing a system 7.1 or later operating system.

Important

❒ If you are using Mac OS 8.1 or later, and LaserWriter 8.5.0 or later, copy the
“PrintingLib” file from the [Extensions] folder in the [System Folder] to your
desktop before installing the PostScript printer driver. After installing the
PostScript printer driver, drag the “PrintingLib” file from your desktop back
into the [Extensions] folder before step G.

❒ You cannot use LaserWriter 8.5.0, if you do not copy “PrintingLib” back into
the [Extensions] folder, or you forgot to copy the “PrintingLib”, please rein-
stall the Macintosh operating system again. 

A Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

B Double-click the CD-ROM icon.

C Double-click the [PS] folder.

D Double-click the folder of the language you use.
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E Open [DISK1] and double-click the installer icon.

F Follow the instructions on the screen.

GMove the “PrintingLib” file from your desktop back to [Extensions] in [Sys-
tem Folder].

H Double-click [Extensions].

I Double-click [Printer Descriptions].

J Double-click the CD-ROM icon on the desktop.

K Double-click the [DISK1] folder in the folder of the language you use.

L Click and drag the PPD file into [Printer Descriptions].

M Restart the Macintosh.

Setting up the PPD file

Preparation

Confirm that the printer is connected to an AppleTalk network before per-
forming the following procedure.

A From the [Apple] menu, select [Chooser].

B Click the [AdobePS] icon.

C From the [Select a PostScript Printer:] list, select the name of the printer you
want to use by clicking it.

D Click [Create].

E Select the printer you want to use by clicking it, and then click [Select].

The PPD file is set up, and the Adobe PS icon appears at the left of the printer
name in the list. Next, use the procedure on P.64 “Setting up options” to make
the option settings, or close the [Chooser] dialog box.

Setting up options

A On the Apple menu, select [Chooser].

B Click the [Adobe PS] icon.

C In the [Select the PostScript Printer] list, select the name of the printer you
want to use by clicking it, and then click [Setup].
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D Click [Configure].

A list of options appears.

E Select the option you want to set up and select the appropriate setting for it.

Note

❒ If the option you want to set up is not displayed, the PPD file might not be
set up correctly. Check the name of the PPD file shown in the dialog box.

F Click [OK].

The list of options closes.

G Click [OK].

The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.
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Uninstalling the PostScript Printer Driver 

This section describes instructions for uninstalling the printer driver. The actual
procedure differs somewhat depending on your operating system.

Follow the appropriate one of the following procedures.

Windows 95/98 - Uninstalling the PostScript Printer Driver

A Click [Start] on the task bar.

B Point to [Settings] and click [Printers].

C Select the printer you want to delete.

D On the [File] menu, click [Delete].

A confirmation dialog box appears. 

E Click [Yes] to delete the printer driver.

Windows 3.1x - Uninstalling the PostScript Printer Driver

A From the [Main] group of the [Program Manager], open [Control Panel] by dou-
ble-clicking it.

B Double-click the [Printers] icon.

C Select the printer you want to delete and click [Remove].

A confirmation dialog box appears. 

D Click [Yes] to delete the printer.

E Click [Close] to finish removing the printer driver.

Windows NT 4.0 - Uninstalling the PostScript Printer Driver

Limitation

❒ Uninstalling a printer driver requires Full Control access permission. Mem-
bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control permission by default.

A Click [Start] on the task bar.

B Point to [Settings] and click [Printers].

C Select the printer you want to delete.
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D On the [File] menu, click [Delete].

A confirmation dialog box appears. 

E Click [Yes] to delete the printer driver.

Macintosh - Uninstalling the PostScript Printer Driver

A Open [System folder] and double-click [Extensions].

B Drag the “Adobe PS” file to [Trash].
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6. Installing the Font Manager

Installing the Font Manager

Printing under a Windows system using PCL 6 or PCL 5e requires installation
of the Font Manager for your operating system. This section describes instruc-
tions for installing the Font Manager.

The actual procedure differs somewhat depending on your operating system.

Follow the appropriate one of the following procedures.

Windows 95/98/NT 4.0 - Installing the Font Manager

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

If the setup menu starts automatically, follow the instructions on the screen.
Otherwise, continue to step C.

C Click [Start] on the task bar.

D Click [Run].

E  In the [Run] window, click [Browse]. 

F Select the CD-ROM drive.

G Open [FONTMAN]. 

H Open [DISK1].

I Open the file titled "Setup.exe".

J Click [OK].

K Follow the instructions on the screen.

Windows 3.1x - Installing the Font Manager

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” in the CD-ROM
drive.

C From [Program Manager], click [Run] on the [File] menu.
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D  In the [Run] window, click [Browse]. 

E Select the CD-ROM drive from the [Drives] list box.

F Open [FONTMAN]. 

G Open [DISK1].

H Open the file titled "Setup.exe".

I Click [OK].

J Follow the instructions on the screen.
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Uninstalling the Font Manager

This section describes instructions for uninstalling the Font Manager. The actual
procedure differs somewhat depending on your operating system.

Follow the appropriate one of the following procedures.

Windows 95/98/NT 4.0 - Uninstalling the Font Manager

A Click [Start] on the task bar.

B Point to [Settings] and click [Control Panel].

C Double-click the [Add/Remove Programs] icon.

D Click [AGFA Font Manager] in the list box.

E Click [Add/Remove].

A confirmation dialog box appears.

F Click [Yes].

G Follow the instructions on the screen.

Windows 3.1x - Uninstalling the Font Manager

A From [Program Manager], double-click [AGFA Font Manager].

B Double-click  [UnInstallShield].

C Follow the instructions on the screen.
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7. Setting Up The Printer Driver
and Canceling a Print Job

PCL 6/5e - Accessing the Printer Properties

Windows 95/98 - Accessing the Printer Properties

There are two methods you can use to open the Printer Properties.

Making printer default settings

To make the printer default settings, first open the Printer Properties from the
[Printers] window.

Note

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

A Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appears.

D Set desired settings and click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Proper-
ties from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows 95.

Note

❒ The actual procedures you should follow to open the Printer Properties dif-
fers slightly depending on the application. For details, see the documentation
that comes with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.
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B From the [Name:] list box, select the printer you want to use, and then click
[Properties].

The Printer Properties appears.

C Set desired settings and click [OK].

D Click [OK] to start your printing.

Windows 3.1x - Accessing the Printer Setting Dialog Box

There are two methods you can use to open the Printer Setting dialog box.

Making printer default settings

To make the printer default settings, open the Printer Setting dialog box from
[Control Panel].

Note

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

A From [Program Manager], open the [Main] group.

B Double-click [Control Panel].

C Double-click the [Printers] icon.

D In the [Installed Printers:] list box, click the name of the printer you want to
set up.

E Click [Setup].

F Set desired settings and click [OK].

G Click [Close] to close the [Printers] dialog box.

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Setting
dialog box from that application. The following example describes how to make
settings for the Write application that comes with Windows 3.1x.

Note

❒ The actual procedures you should follow to open the Printer Setting dialog
box differs slightly depending on the application. For details, see the docu-
mentation that comes with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.
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❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print Setup].

[Print Setup] appears.

B From the [Printer] group, select the printer you want to use.

Note

❒ If the printer you want to use is not specified as the default printer, click
[Specific Printer:] and then find the printer you want to use in the list box.

C Click [Options].

The Printer Setting dialog box appears.

D Set desired settings and click [OK].

E Click [OK] to close the [Print Setup] dialog box.

F Start your printing.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ Changing the settings of the printer requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default.

A Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default setting you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appears.

D Set desired settings and click [OK].

Note

❒ Setting you make here are used as the default settings for all applications.
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Making printer default settings – Default Document Properties

Limitation

❒ Changing the settings of the printer requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default.

A Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Document Defaults].

The Default Document Properties appears.

D Set desired settings and click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the Document Prop-
erties from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows NT 4.0.

Note

❒ The actual procedures you should follow to open the Document Properties
differs slightly depending on the application. For details, see the documenta-
tion that comes with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B From the [Name:] list box, select the printer you want to use, and then click
[Properties].

The Document Properties appears.

C Set desired settings and click [OK].

D Click [OK] to start your printing.
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PostScript - Setting Up for Printing

Windows 95/98 - Accessing the Printer Properties

There are two methods you can use to open the Printer Properties.

Making printer default settings

To make the printer default settings, first open the Printer Properties from the
[Printers] window.

Note

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

A Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appears.

D Set desired settings and click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Proper-
ties from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows 95.

Note

❒ The actual procedures you should follow to open the Printer Properties dif-
fers slightly depending on the application. For details, see the documentation
that comes with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B From the [Name:] list box, select the printer you want to use, and then click
[Properties].

The Printer Properties appears.
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C Set desired settings and click [OK].

D Click [OK] to start your printing.

Windows 3.1x - Accessing the Printer Setting Dialog Box

There are two methods you can use to open the Printer Setting dialog box.

Making printer default settings

To make the printer default settings, open the Printer Setting dialog box from
[Control Panel].

Note

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

A From [Program Manager], open the [Main] group.

B Double-click [Control Panel].

C Double-click the [Printers] icon.

D In the [Installed Printers] list box, click the name of the printer you want to set
up.

E Click [Setup].

F Set desired settings and click [OK].

G Click [Close] to close the [Printers] dialog box.

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Setting
dialog box from that application. The following example describes how to make
settings for the Write application that comes with Windows 3.1x.

Note

❒ The actual procedures you should follow to open [Print Setup] differs slightly
depending on the application. For details, see the documentation that comes
with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.
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A On the [File] menu, click [Print Setup].

[Print Setup] appears.

B From the [Printer] group, select the printer you want to use.

Note

❒ If the printer you want to use is not specified as the default printer, click
[Specific Printer:] and then find the printer you want to use in the list box.

C Click [Options].

The Printer Setting dialog box appears.

D Set desired settings and click [OK].

E Click [OK] to close the [Print Setup] dialog box.

F Start your printing.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ Changing the settings of the printer requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default.

A Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appears.

D Set desired settings and click [OK].

Note

❒ Setting you make here are used as the default settings for all applications.
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Making printer default settings - Default Document Properties

Limitation

❒ Changing the settings of the printer requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default.

A Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Document Defaults].

The Default Document Properties appears.

D Set desired settings and click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the Document Prop-
erties from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows NT 4.0.

Note

❒ The actual procedures you should follow to open the Document Properties
differs slightly depending on the application. For details, see the documenta-
tion that comes with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own initial default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B From the [Name] list box, select the printer you want to use, and then click
[Properties].

The Document Properties appears.

C Set desired settings and click [OK].

D Click [OK] to start your printing.
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Macintosh - Setting Up for Printing

Making paper settings from an application

A Open the file you want to print.

B On the [File] menu, click [Page Setup].

[Adobe PS Page Setup] appears.

C Confirm that the printer you want to use is shown in [Format for:].

Note

❒ If your printer is now shown in the [Format for:] box, use the pop-up menu
to display a list of available printers.

Reference

The actual appearance of the Page Setup depends on the application you
are using. See the documentation that comes with your Macintosh for de-
tails.

D From the [Paper] pop-up menu, select the paper size.

E Set desired settings and click [OK].

Setting up for printing from an application

A Open the file you want to print.

B On the [File] menu, click [Print].

The Printer Settings appears.

C Confirm that your printer is selected in the [Printer:] box.

D Set desired settings and click [Print].
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Canceling a Print Job

Windows 95/98 - Canceling a Print Job

A Double-click the printer icon on the task bar.

This opens a window that shows all the print jobs that are currently queued
for printing. Check the current status of the job you want to cancel. 

B Click the name of the job you want to cancel so it is highlighted.

C On the [Document] menu, click [Cancel Printing]. 

Note

❒ You can also open the print job queue window by double-clicking the
printer icon in the [Printers] window.

D Press the printer's {Job Reset} key. 

The message appears on the panel display indicating that the print job is be-
ing cancelled. 

Important

❒ The preceding procedure cancels the print job that is currently being proc-
essed by the printer. In some cases, the printer might already be processing
data for the next print job following the one currently being output. In such
a case, the next print job is also canceled when you press {Job Reset}.

❒ When your printer is being shared by multiple computers, confirm you do
not accidentally cancel someone else's print job.

Note

❒ You cannot stop printing data that has already been processed internally
by the printer. Because of this, printing might continue for a few pages af-
ter you press {Job Reset}.

❒ A print job that contains a large volume of data might take considerable
time to stop.

Windows 3.1x - Canceling a Print Job

A  In the [Main] group, double-click the [Print Manager] icon.

 This opens a window that shows all the print jobs that are currently queued
for printing.

B Click the name of the job you want to cancel so it is highlighted.

C On the [Document] menu, click [Delete Document].
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D Click [OK] to close the dialog box.

E Press the printer's {Job Reset} key. 

The message appears on the panel display indicating that the print job is be-
ing cancelled. 

Important

❒ The preceding procedure cancels the print job that is currently being proc-
essed by the printer. In some cases, the printer might already be processing
data for the next print job following the one currently being output. In such
a case, the next print job is also canceled when you press {Job Reset}.

❒ When your printer is being shared by multiple computers, confirm you do
not accidentally cancel someone else's print job.

Note

❒ You cannot stop printing data that has already been processed internally
by the printer. Because of this, printing might continue for a few pages af-
ter you press {Job Reset}.

❒ A print job that contains a large volume of data might take considerable
time to stop.

Windows NT 4.0 - Canceling a Print Job

A Double-click the printer icon on the task bar.

This opens a window that shows all the print jobs that are currently queued
for printing. Check the current status of the job you want to cancel. 

B Click the name of the job you want to cancel so it is highlighted.

C On the [Document] menu, click [Cancel]. 

Note

❒ You can also open the print job queue window by double-clicking the
printer icon in the [Printers] window.

D Press the printer's {Job Reset} key. 

The message appears on the panel display indicating that the print job is be-
ing cancelled. 

Important

❒ The preceding procedure cancels the print job that is currently being proc-
essed by the printer. In some cases, the printer might already be processing
data for the next print job following the one currently being output. In such
a case, the next print job is also canceled when you press {Job Reset}.

❒ When your printer is being shared by multiple computers, confirm you do
not accidentally cancel someone else's print job.
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Note

❒ You cannot stop printing data that has already been processed internally
by the printer. Because of this, printing might continue for a few pages af-
ter you press {Job Reset}.

❒ A print job that contains a large volume of data might take considerable
time to stop.

Macintosh - Canceling a Print Job

A Double-click the printer icon on the Desktop.

This opens a window that shows all the print jobs that are currently queued
for printing. Check the current status of the job you want to cancel. 

B Click the name of the job you want to cancel so it is highlighted.

C Click [Pause Button], and then click [Trash Button]. 

D Press the printer's {Job Reset} key. 

The message appears on the panel display indicating that the print job is be-
ing cancelled. 

Important

❒ The preceding procedure cancels the print job that is currently being proc-
essed by the printer. In some cases, the printer might already be processing
data for the next print job following the one currently being output. In such
a case, the next print job is also canceled when you press {Job Reset}.

❒ When your printer is being shared by multiple computers, confirm you do
not accidentally cancel someone else's print job.

Note

❒ You cannot stop printing data that has already been processed internally
by the printer. Because of this, printing might continue for a few pages af-
ter you press {Job Reset}.

❒ A print job that contains a large volume of data might take considerable
time to stop.
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8. Paper and Other Media

Paper and Other Media Supported by 
Your Printer

Paper Types and Sizes

This section describes the type, size, feed direction, and maximum capacity of
paper that can be loaded into each paper tray in this printer.

Important

❒ Be sure to set the paper size dial to match the actual paper size loaded in the
tray. When the actual paper size is not shown on the dial, set the dial to “p”
and specify the paper size using the operation panel.

Note

❒ The meaning of the symbols describing paper can be seen in the following ta-
ble.

❒ It is recommended that you load paper having the size and direction you fre-
quently use in the tray selected with the “Tray Priority”. For details on Tray
Priority, see P.134 “Job Control Parameters”.

❒ When loading paper having the same size in more than one tray, it is recom-
mended that you load paper in the same direction.

❒ Regarding the meanings of the abbreviations, see the notes following each ta-
ble.

In this manual Meaning

K long-edge feed direction

L short-edge feed direction
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❖ Paper Sizes (Metric version)

*1 The size is not supported in the duplex printing.
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A3 L 297 × 420 ❍* ✩ ✩ X

B4 JIS L 257 × 364 ❍* ★ ★ X

A4 K 297 × 210 X ✩ ✩ ❍*

L 210 × 297 ❍* ✩ ✩ X

B5 JIS K 257 × 182 X ★ ★ X

L 182 × 257 ❍* ★ ★ X

A5 L 148 × 210 ❍* ✩ ✩ X

A6 *1 L 105 × 148 ❍* X X X

Double Letter

(DLT, 11" × 17")

L 279 × 432 ❍* ★ ★ X

Legal (LG, 81/2" × 14") L 216 × 356 ❍* ★ ★ X

Letter (LT, 81/2" × 11") K 279 × 216 X ✩ ✩ ❍*

L 216 × 279 ❍* ✩ ✩ X

Half Letter

(HLT, 51/2" × 81/2")

L 140 × 216 ❍* ★ ★ X

Executive

(Exec., 71/4" × 101/2")

L 184 × 267 ❍* ★ ★ X

Folio (81/4" × 13") L 210 × 330 ❍* ★ ★ X

Foolscap (F4, 81/2" × 13") L 216 × 330 ❍* ★ ★ X

F/GL (8" × 13") L 203 × 330 ❍* ✩ ✩ X
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• ❍ means that the size is supported and you need to specify the paper size us-
ing the operation panel. (Regarding the bypass tray and the Large Capacity
Tray RT36, there is no dial on the tray.)

• ✩ means that the size is supported and indicated on the tray dial. Be sure to
set the paper size dial to match the actual paper size loaded in the tray.

• ★ means that the size is supported but not indicated on the tray dial. You
should set the tray dial to “p”, and specify the paper size using the operation
panel.

• ❍* means that the size is supported and you need to specify the paper size
using the printer driver.

• X means that the size is not supported.

Important

❒ If you want to load 81/2" × 11"K size paper into the Large Capacity Tray
RT36, contact your sales or service representative.
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❖ Paper Sizes (Inch version)

*1 The size is not supported in the duplex printing.
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Double Letter (DLT) L 11" × 17" ❍* ✩ ✩ X

Legal (LG) L 81/2" × 14" ❍* ✩ ✩ X

Letter (LT) K 11" × 81/2" X ✩ ✩ ❍*

L 81/2" × 11" ❍* ✩ ✩ X

Half Letter (HLT) L 51/2" × 81/2" ❍* ★ ★ X

Executive (Exec.) L 71/4" × 101/2" ❍* ★ ★ X

A3 L 11.26" × 16.54" ❍* ★ ★ X

B4 JIS L 10.12" × 14.33" ❍* ★ ★ X

A4 K 11.69" × 8.27" X ✩ ✩ ❍*

L 8.27" × 11.69" ❍* ✩ ✩ X

B5 JIS K 10.12” × 7.17" X ★ ★ X

L 7.17" × 10.12" ❍* ★ ★ X

A5 L 5.83" × 8.27" ❍* ★ ★ X

A6 *1 L 4.13" × 5.83" ❍* X X X

Folio L 81/4" × 13" ❍* ★ ★ X

Foolscap F4 L 81/2" × 13" ❍* ✩ ✩ X

F/GL L 8" × 13" ❍* ★ ★ X
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• ❍ means that the size is supported and you need to specify the paper size us-
ing the operation panel. (Regarding the bypass tray and the Large Capacity
Tray RT36, there is no dial on the tray.)

• ✩ means that the size is supported and indicated on the tray dial. Be sure to
set the paper size dial to match the actual paper size loaded in the tray.

• ★ means that the size is supported but not indicated on the tray dial. You
should set the tray dial to “p”, and specify the paper size using the operation
panel.

• ❍* means that the size is supported and you need to specify the paper size
using the printer driver.

• X means that the size is not supported.

Important

❒ If you want to load A4K size paper into the Large Capacity Tray RT36, con-
tact your sales or service representative.

❖ Paper weight and number of sheets to be set

*1 Confirm that the top of the stack is not higher than the limit mark indicated on the
side guide of the tray.

Precautions for Paper

Note the following precautions when handling or selecting paper to be used
with this printer.

Supported paper 
weight

Maximum number of 

sheets (plain paper) *1 

Bypass Tray 52 - 157 g/m2 (16 - 42 lb) 50 (80 g/m2, 20 lb)

For other kind of papers, 
see P.90 “Paper types and 
cautions”.

Standard Tray (Tray 1/2) 64 - 105 g/m2 (20 - 28 lb) 500 (80 g/m2, 20 lb)

Paper Bank PS430 (option) 64 - 105 g/m2 (20 - 28 lb) 500 (80 g/m2, 20 lb)

Large Capacity Tray RT36 (op-
tion)

64 - 105 g/m2 (20 - 28 lb) 1,500 (80 g/m2, 20 lb)
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Cautions in loading paper

• Use only the recommended paper types. Print quality cannot be guaranteed
if other paper types are used.

• Do not use paper that is already printed on. 

• When loading paper into the paper tray or the Large Capacity Tray RT36,
confirm that the top of the stack is not higher than the limit mark inside the
tray.

• When loading paper onto the bypass tray, confirm that the top of the stack is
not higher than the limit mark of the paper guide.

• When loading paper into the paper tray, confirm that print side is facing up.

• When loading paper onto the bypass tray or the Large Capacity Tray RT36,
confirm that print side is facing down.

Cautions in storing paper

Paper should always be stored properly. Improperly stored paper might result
in poor print quality, paper misfeeds, or printer damage.

Follow the following precautions.

• Avoid storing paper in humid areas.

• Avoid exposing paper to direct sunlight.

• Store on a flat surface.

• Keep open reams of paper in the package in which the paper came.

Paper types and cautions

❖ Plain paper

• If you print on paper heavier than 105 g/m2 (28 lb), use the bypass tray.
The bypass tray can hold paper up to 157 g/m2 (42 lb) in weight.

• When loading paper heavier than 155 g/m2 (41 lb) onto the bypass tray, set
the printer to the Thick Paper mode using the operation panel. ⇒ P.129
“Using the Operation Panel”

• If paper is curled or bent, correct it before loading.

❖ OHP transparencies

• Load only one OHP transparency at a time onto the bypass tray.

• When loading OHP transparencies onto the bypass tray, set the printer to
the OHP sheet mode using the operation panel. ⇒ P.129 “Using the Opera-
tion Panel”

• Be careful not to touch the print side of the OHP transparencies. Other-
wise, the print side gets dirty or damaged, and results in poor print quality.

• When printing on an OHP transparency that has a print side, load it face
down onto the bypass tray.



Paper and Other Media Supported by Your Printer

91

8

❖ Translucent paper

• Load only one translucent paper at a time onto the bypass tray.

• When printing on translucent paper that has a print side, load it face down
onto the bypass tray.

❖ Adhesive labels

• Load only one adhesive label at a time onto the bypass tray.

• Use adhesive labels in which the whole side can be printed on.

• Avoid using adhesive labels having exposed glue.

• If the print side is coated, the print quality might be reduced, as the toner
might not fuse well.

Paper not supported by this printer

Avoid using the following types of paper that are not supported by this printer:

• Paper whose weight is heavier or lighter than the limitation. ⇒ P.85 “Paper
Types and Sizes”

• Bent, folded, or creased paper

• Curled or twisted paper

• Torn paper

• Wrinkled paper

• Damp paper

• Paper stuck together

• Paper that is dry enough to emit static electricity

• Paper that has already been printed except preprinted letterhead

Note

❒ Ink on paper from an earlier print job, another copier, an inkjet printer or
other device could damage the fusing unit of this printer due to a differ-
ence in fusing temperatures.

• Coated paper (except the recommended one)

• Special paper like thermal paper, aluminum foil, carbon paper and conduc-
tive paper

• Heavily textured paper

• Glued paper

• Label paper on which glue or base paper is exposed

• Paper with clips or stapled

• Paper with tape or ribbons attached

• Envelopes
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Printable Area

The following shows the printable area for this printer. Be sure to set the print
margins correctly.

A : printable area

Note

❒ The printable area might vary depending on paper size, printer language and
printer driver settings.

2mm (1/12"  )

3mm
(1/8")

1

2mm (1/12"  )

2mm
(1/12"  )

2mm (1/12"  )2mm (1/12"  )
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Loading Paper and Other Media

Loading Paper in the Paper 
Tray

This section describes instructions for
loading paper whose size and feed di-
rection is already set in the standard
paper tray and the optional paper
bank PS430. If you want to change the
paper size or feed direction, see P.94
“Changing Paper Size of the Paper
Tray”.

Important

❒ Confirm that the setting of the pa-
per size dial matches the paper size
and feed direction of the paper in
the tray. Otherwise, the printer
might be damaged, or printing
problems might occur.

Reference

For more information on the size
and feed direction of paper that
can be loaded in the tray, see P.85
“Paper Types and Sizes”.

A Slide the paper tray out until it
stops.

B Remove the rear guide.

C Align all four sides of the paper
stack and load it into the tray.

Important

❒ Confirm that the top of the stack
is not higher than the limit mark
inside the tray. 

DWhile lifting the left side of the
paper, attach the rear guide.

TAPY010E

1

2
1

TAPY012E

TAPY021E

TAPY591E
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E Slide the tray into the printer un-
til it stops.

Changing Paper Size of the 
Paper Tray

Important

❒ Confirm that the setting of the pa-
per size dial matches the paper size
and feed direction of the paper in
the tray. Otherwise, the printer
might be damaged, or printing
problem might occur.

❒ If you load A3L, B4 JISL,
11"x17"L and 8 1/2"x14"L size
paper into Tray 1, attach the cush-
ion (A) and pad (B) as shown in
the illustration. Attach the cushion
(A) on the left back side of the
front cover of Tray 1. The cushion
should touch the bottom and the
wall. Attach the pad (B) on the
side guide on the printer side. The
pad should be between the ribs
and 1 - 2 mm (0.04" - 0.08") from the
top.

Reference

For more information on the size
and feed direction of paper that
can be set in the tray, see P.85 “Pa-
per Types and Sizes”.

A Slide the paper tray out until it
stops. After that, lift it up slightly,
then pull it out.

B Remove the rear guide.

C Pull the standard paper tray (Tray
1), and take the screwdriver (A)
from the tray.

TAPY581E

TAPY800E

TAPH210E

TAPY063E

1

2

1

TAPP720E
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D Remove the four screws inside of
the tray you removed in step A. 

E Re-position the side guide to hold
the paper size you want to load.

F Lock the side guides with the four
screws you removed in step D.

G Align all four sides of the paper
stack and load it into the tray.

Important

❒ Confirm that the top of the stack
is not higher than the limit mark
inside the tray.

HWhile lifting the left side of the
paper, attach the rear guide.

Note

❒ For 11” × 17”L size paper, re-
move the rear guide and place it
in the guide storage space (A).

TAPY041E

TAPY051E

TAPY062E

TAPY091E

TAPY092E

TAPY093E
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I Adjust the paper size dial to
match the size and feed direction
of the paper in the paper tray.

Important

❒ If you want to use paper size
and feed direction that are not
indicated on the paper size dial,
set the dial to "p". In this case,
you should specify the paper
size using the operation panel.
⇒ P.132 “Making Printer Settings
with the Operation Panel”

J Slide the tray into the printer gen-
try until it stops.

Loading Paper in the Bypass 
Tray

Reference

For more information on the size
and feed direction of paper that
can be set in the tray, see P.85 “Pa-
per Types and Sizes”.

A Open the bypass tray.

Note

❒ Swing out the extender (A) to
support paper sizes larger than
A4L.

B Slide the paper guides outwards,
and load paper until it stops with
the print side down.

C Adjust the paper guides to the pa-
per width.

Important

❒ Confirm that the top of the stack
is not higher than the limit mark
of the paper guide.

TAPY090E

TAPH221E

TAPY600E

TAPY610E

TAPY620E



Loading Paper and Other Media

97

8

Loading Paper in the Optional 
Large Capacity Tray

This section describes instructions to
load paper in the optional Large Ca-
pacity Tray RT36.

Reference

For more information on the size
and feed direction of paper that
can be set in the tray, see P.85 “Pa-
per Types and Sizes”.

A Check if the tray release button is
lit. If it is not lit, press the button
to lit it.

BWhen the button stops blinking
and is lit, open the top cover.

C Load paper with the long-edge
side of the paper pressing against
the printer side.

Important

❒ Confirm the top of the stack is
not higher than the limit mark
inside the tray.

D Close the top cover.

TAPM241E

TAPM160E

TAPY560E

TAPM230E
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9. Troubleshooting

Error & Status Messages on the Operation 
Panel

Messages Description Comments

Add Staple The staple is almost empty. Replace the staple refill with a 
new one. ⇒ P.120 “Adding Sta-
ples”

Call Service

SC###

An error has occured in the 
printer.

Turn the printer power off and 
on. If the message appears again, 
contact your sales or service rep-
resentative.

ChangeFeedRoller It is time to replace the pa-
per feed roller.

Contact your sales or service rep-
resentative.

Change Maint.Kit It is time to replace parts in-
cluded in the Maintenance 
Kit.

Replace parts. For more informa-
tion on the Maintenance Kit, see 
"Maintenance Kit Type 4500 Re-
placement Guide" that comes 
with the Kit.

Close Bridge

Unit Cover

The cover of the bridge unit 
is open.

Close the cover of the bridge unit.

Close

Duplex Unit

The duplex unit is open. Close the duplex unit.

Close

Finisher Cover

The cover of the finisher is 
open.

Close the cover of the finisher.

Close

Front Cover

The front cover is open. Close the front cover of the print-
er.

Close LCT Cover The cover of the Large Ca-
pacity Tray RT36 is open.

Close the cover of the Large Ca-
pacity Tray RT36.

Close

Mailbox Cover

The cover of the Mailbox 
CS360 is open.

Close the cover of the Mailbox 
CS360.

Close

Right Cover

The right cover is open. Close the right cover.

Close Right

Lower Cover

The lower vertical paper 
feed is open.

Close the lower vertical paper 
feed cover.
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Error: Finisher The stapler is damaged. The stapler needs to be repaired.

Contact your sales or service rep-
resentative.

Load  {paper size}

Tray #

Tray # is empty. Load {paper size} paper into Tray 
#. ⇒ P.93 “Loading Paper and Oth-
er Media”

Note

❒ The paper size in millimeters 
is displayed as 
"(length×width)". For exam-
ple "Load A4(297×210)" 
means "load A4K", and "Load 
A4(210×297)" means "load 
A4L".

❒ Depending on the language 
you use, only the length may 
be displayed. If "Load 
A4(297×)" is displayed, load 
A4K.

❒ If there is only one possible 
feed direction, depending on 
the language you use, the pa-
per size in millimeters may 
not be displayed.

Low on Toner The toner bottle is almost 
empty.

Prepare a new toner bottle. If the 
image density is too light, replace 
the old toner bottle with a new 
one. ⇒ P.127 “Replacing the Toner 
Bottle”

Misfeed:{location}

Open Front Cover

There is a misfeed in the 
printer.

Remove the misfed papers from 
{location}. ⇒ P.108 “Removing 
Misfed Paper”

Open Duplex

Side Tray

The right cover of the du-
plex unit is not open when 
making duplex printing on 

A3, B4 JIS , 11" × 17", or 81/2" 

× 14"K size paper. 

Open the duplex unit right cover.

Punch Chips Full The punch waste box is full. Remove paper chips. ⇒ P.126 
“Removing Paper Chips”

Remove Paper:

Mailbox Proof

The mailbox tray is full. Remove paper from the Mailbox 
CS360.

Messages Description Comments
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Note

❒ If you cannot solve the problem by taking the actions listed in the preceding
table, turn the printer power off and then back on again. If this does not clear
the error message, take a note of the contents and number of the error mes-
sage and contact your sales or service representative.

Remove Paper:

Shift Tray

The shift tray of the Finisher 
SR730 is full.

Remove paper from the shift 
tray.

Remove Paper:

Standard Tray

The standard output tray is 
full.

Remove paper from the output 
tray.

Remove Paper:

Staple Tray

There is paper in the stack 
unit of the finisher.

Remove paper from the stack 
unit of the finisher.

Replace Toner The toner bottle is empty. Replace the old toner bottle with 
a new one. ⇒ P.127 “Replacing the 
Toner Bottle”

Reset Fusing

Unit Correctly

There is no fusing unit, or 
the fusing unit is not in-
stalled properly. 

Install the fusing unit properly. 
For more information on the fus-
ing unit, see the "Maintenance Kit 
Type 4500 Replacement Guide" 
that comes with the maintenance 
kit.

Reset Tray #

Correctly

There is no paper tray, or 
Tray # is not set correctly.

Set the tray correctly.

Messages Description Comments
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Printer Doesn't Print

Possible Cause Solutions

Is the power on? If not, confirm that the cord is securely plugged into the 
power outlet and the printer.

Turn on the printer power.

Does the On Line indi-
cator stay on?

If not, press {On Line} to make it light up.

Does the Error indicator 
stay red?

If so, check the error message on the panel display and take 
the required action.

Is the paper set? Load paper into the paper tray, the Large Capacity Tray 
RT36 or the bypass tray.

⇒ P.93 “Loading Paper and Other Media”

Can you print a test 
page (configuration 
page)?

If you can't print a test page, it probably indicates printer 
malfunction. You should contact your sales or service repre-
sentative.

If you can print a test page but cannot get the printer to print 
when you issue a print command from your computer, it 
probably means there is a problem with your computer.

Also keep it in mind that large, complex data might take 
long time for printer process.

Is the parallel cable be-
tween the printer and 
your computer connect-
ed securely?

Connect the parallel cable correctly. If there are any connec-
tors or screws, confirm they are fastened securely.

Are you using a correct 
parallel cable?

The type of parallel cable you should use depends on your 
computer. Be sure to use the correct one. ⇒ P.154 “Specifica-
tions”

If the cable is damaged or worn, replace it with a new one.

When printing with 
PostScript in a network, 
data is received by the 
printer, but is not print-
ed.

❖ Windows 95/98
On the [PostScript] tab of the Printer Properties, click [Ad-
vanced] and then uncheck both [Send CTRL+D before job] 
and [Send CTRL+D after job].

❖ Windows 3.x
Click the [PostScript] tab of the Printer Setting dialog box. 
From [Protocol Options], select [None].

❖ Windows NT 4.0
Open the [Advanced] tab of the Printer Properties. From 
[PostScript Options], select [No] for both [Send CTRL-D Be-
fore Each job:] and [Send CTRL-D After Each job:].
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If you print using Post-
Script driver, printing 
does not start or is inter-
rupted.

The data is cleared when the Job Timeout period is exceed-
ed.

❖ Windows 95/98
Set a longer [Job Timeout] period with the [PostScript] tab 
of the Printer Properties.

❖ Windows 3.1x
Set a longer [Job Timeout] period with the [PostScript] tab 
of the Printer Setting dialog box.

❖ Windows NT 4.0
Set a longer [Job Timeout] period with the [Device Settings] 
tab of the Printer Properties. 

A PostScript error might occur if there is not enough mem-
ory in the printer, or there are errors in the print data sent to 
the printer. 

• In some cases, increasing the memory may solve this 
problem. Install a memory unit (SIMM). For more infor-
mation on the memory, see P.14 “Installing the Memory 
Unit”.

The print job might be reset. Do the following.

• Confirm that you have selected the correct printer driv-
er. Try printing again.

• Set a longer Wait Timeout.

❖ Windows 95/98
Set a longer [Wait Timeout] period with the [PostScript] 
tab of the Printer Properties.

❖ Windows 3.1x
Set a longer [Wait Timeout] period with the [PostScript] 
tab of the Printer Setting dialog box.

❖ Windows NT 4.0
Set a longer [Wait Timeout] period with the [Device Set-
tings] tab of the Printer Properties. 

❖ Macintosh
You can specify a longer [I/O Timeout] period on the 
printer's operation panel. ⇒ P.129 “Using the Opera-
tion Panel”

Possible Cause Solutions
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Note

• Windows 95/98

A Click [Start], point to [Settings], and then click [Printers].

B Select the icon of the printer by clicking it. Next, on the [File] menu, click
[Properties].

C Click the [Details] tab.

D Check the [Print to the following port:] list box to confirm the correct port
is selected.

• Windows 3.1x

A On [Control Panel], double-click the [Printers] icon.

B Confirm that this printer is specified as the default printer.

C Click [Connect].

D Check the [Ports] list box to confirm the correct port is selected.

• Windows NT 4.0

A Click [Start], point to [Settings], and then click [Printers].

B Select the icon of the printer by clicking it. Next, on the [File] menu, click
[Properties].

C Click the [Port] tab.

D Confirm that the correct port is selected.

• Macintosh

A Click [Apple Menu], point to [Control Panels], and then select [Apple Talk].

B Confirm that [Ethernet] is selected in the [connect via:] list box.

Is the Data In indicator 
blinking or lit after start-
ing the print job, when 
using the PCL printer?

If not, the data is not being sent to the printer. Or the printer 
may be resetting the print job because there was a long de-
lay in receiving the data from the computer.

❖ If the printer is using "I/O Timeout"
Increase the value of the "I/O Timeout" setting of the 
"System" menu of the "Job Control". ⇒ P.129 “Using the 
Operation Panel”

❖ If your printer is connected to the computer using the 
parallel cable
Confirm that the printer port settings are correct. For a 
parallel port connection, port LPT1 or LPT2 should be 
set. 
For more information on the printer port settings, see the 
Note after this table.

❖ Network Connection
Contact your network administrator.

Possible Cause Solutions
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Other Printing Problems

Status Possible Causes, Descriptions, and Solutions

Printed side is dirty. Adjust the image density correctly.

⇒ P.129 “Using the Operation Panel”

If paper is curled, correct it.

The back side of the printed 
output is dirty.

Check if the size specified with the dial matches that 
specified with the operation panel. If not, specify the 
correct size that matches the size and feed direction of 
the paper loaded in the tray.

If you print something after printing on the paper 
whose size is smaller than the actual document size, 
the back side of the next output might get dirty.

⇒ P.93 “Loading Paper and Other Media”

Image quality varies when 
printing on thick paper or on 
OHP transparencies.

Set to Thick Paper or OHP Sheet mode in the “Bypass 
Pap.Type” menu.

⇒ P.129 “Using the Operation Panel”

Print image is not clear. Set the image density to darker.

⇒ P.129 “Using the Operation Panel”

If the Toner Saving mode is specified using the opera-
tion panel, the whole image gets lighter. See the driv-
er's online help file.

Some parts of the print image 
are not clear.

Due to a sudden change in temperature, condensation 
might appear inside the machine, and reduce the print 
quality. If this occurs when you move the printer from 
a cold room to a warmer room, don't use the printer 
until it gets used to the temperature. 

Image is printed on the re-
verse side of the paper.

Set the paper upside down.

Paper misfeeds occur fre-
quently.

Check the paper size settings. The size specified with 
the paper size dial might be different from the actual 
paper size. Make the correct dial setting. ⇒ P.93 “Load-
ing Paper and Other Media”

Use the recommended paper. Avoid using curled, 
folded, or wrinkled paper, perforated paper, or glossy 
paper. ⇒ P.91 “Paper not supported by this printer”

Confirm that the side guides and the rear guide of the 
paper tray are set in place. ⇒ P.93 “Loading Paper and 
Other Media”
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Operation panel error mes-
sage stays on after removing 
the misfed paper.

Open the front cover of your printer and then close it. 
Be sure to close the lower vertical paper feed cover. ⇒ 
P.108 “Removing Misfed Paper”

Desired tray isn't used for the 
output.

Check the paper size settings. The size specified with 
the paper size dial might be different from the actual 
paper size. Make the correct dial setting. ⇒ P.93 “Load-
ing Paper and Other Media”

When you are using a Windows operating system, the 
printer driver settings overrides those specified using 
the operation panel. Specify the desired output tray us-
ing the printer driver. See the driver's online help file.

The printed image is differ-
ent from the image in the 
computer.

When you use some features such as enlargement and 
reduction, the layout of the image might be different 
from those shown in the computer display. Before 
printing, use the print preview to see how the page will 
look when printed. If necessary, adjust the settings.

It takes too much time to 
resume printing.

The data is so large or complex that it takes time to 
process it. If the Data In indicator is blinking, the data 
processing is being done. Just wait until it resumes.

Energy Saver mode might be enabled. In Energy Saver 
mode, it takes time for the machine to warm up. ⇒ 
P.129 “Using the Operation Panel”

Image is printed in the 
wrong orientation.

Specify the correct orientation under the “PCL Menu” 
with the operation panel. ⇒ P.129 “Using the Operation 
Panel”

Part of the image cannot be 
printed.

A paper size which is smaller than those specified in 
the application is used for printing. Load the correct 
size of paper. If you can't select the paper size specified 
in the application, make use of the zooming features. 
See the driver's online help file.

Network configurations you 
have made do not become ef-
fective.

Turn the printer power off and on. The network config-
uration page of the Network Interface Board will be 
printed automatically. Check the configuration of the 
Network Interface Board with this page.

The output from the Finisher 
SR730 is curled and a paper 
misfeed has occurred with 
the Finisher SR730.

A paper misfeed may have occured because of curled 
paper in the output tray. If the paper output is curled, 
remove the paper from the paper tray and load it again 
after turning it over. 

The print resolution of the 
printed image is lower than 
what you set.

The memory installed on the printer is insufficient. In-
crease the printer's memory.

Status Possible Causes, Descriptions, and Solutions
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Note

❒ If the problem cannot be solved, contact your sales or service representative.

Windows 95/98/NT 4.0:

The computer doesn't recog-
nize the installed printer op-
tions.

If connections to the printer is not bi-directional, the 
computer doesn't recognize the installed printer op-
tions.

In this case specify which options you have installed 
using the printer driver.

Reference

For more information on setting options for the 
printer driver. ⇒ P.51 “Installing the PCL 6/5e Printer 
Driver”, P.59 “Installing the PostScript Printer Driver”

Windows 3.1x:

The printer can't send the 
print job.

The memory buffer might be full. Remove the check 
mark from the [Use Print Manager] check box, or make 
the timeout setting longer.

Status Possible Causes, Descriptions, and Solutions
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Removing Misfed Paper

When a paper misfeed occurs, an er-
ror message appears on the panel dis-
play. The procedure you should
follow to remove the misfed paper
depends on the location of the mis-
feed, which is indicated on the panel
display.

R CAUTION:

Important

❒ More than one misfed areas might
be indicated. In this case, check
every applicable area. See the fol-
lowing charts shown in the illus-
tration.

❒ If paper continues to misfeed,
check the following points.

• Confirm that the setting of the
paper size dial matches the size
and feed direction of the paper
loaded in the paper tray.

• Confirm that the toner bottle is
set correctly.

❒ If paper misfeed still occurs, con-
tact your sales or service represent-
ative.

❒ Do not leave any torn paper scraps
within the printer.

When "Misfeed:A" Appears

A Open the bypass tray (A). And
then open the duplex unit by
pushing the catch upwards (B).

B Open the right cover by pushing
the catch upwards.

• When removing misfed paper, 
do not touch the fusing section 
because it becomes very hot.

Y

D C
Z

A
B
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Note

❒ If the optional Large Capacity
Tray RT36 is equipped with
your printer, pull the lever (A)
to extend the connecting unit
(B).

C Open the upper vertical paper
feed cover.

Note

❒ If your printer is equipped with
the optional Large Capacity
Tray RT36,  the upper vertical
paper feed cover is removed.

D Turn the blue knob A1 down-
wards.

EWhile lifting the blue lever A2 in
the right cover (A), remove the
misfed paper (B).

F Close the covers in the following
order:

• The upper vertical paper feed
cover

• The right cover

• The duplex unit

• The bypass tray

When "Misfeed:B" Appears

A Open the bypass tray (A). And
then open the duplex unit by
pushing the catch upwards (B).

1

2
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B Open the right cover by pushing
the catch upwards.

C Open the front cover.

D Turn the blue knob B counter-
clockwise (A) and remove the
misfed paper from inside of the
right cover (B).

E Close the covers in the following
order:

• The right cover

• The duplex unit

• The bypass tray

• The front cover

When "Misfeed:C" Appears

A Open the bypass tray (A). And
then open the duplex unit by
pushing the catch upwards (B).

B Open the right cover by pushing
the catch upwards.

C Open the front cover.

TAPH050E

TAPH072E

TAPY180E

B

TAPH030E
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a

TAPH050E

TAPH072E



Removing Misfed Paper

111

9

D Open the output feeder cover of
the bridge unit.

E Remove the misfed paper by
turning the blue knob C as shown
in the illustration.

If you turn the blue knob C clock-
wise (A) , the misfed paper comes
out to the output tray (B).

If you turn the blue knob C coun-
terclockwise (A), remove the mis-
fed paper from inside of the right
cover (B).

F Close the covers in the following
order:

• The right cover

• The duplex unit

• The bypass tray

• The front cover

• The output feeder cover

When "Misfeed:D" Appears

A Open the output feeder cover of
the bridge unit (A), and remove
the misfed paper (B).

B Open the bypass tray (A). And
then open the duplex unit by
pushing the catch upwards (B).

TAPY750E

TAPY191E
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TAPY220E

TAPH030E
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C Open the right cover by pushing
the catch upwards.

D Open the front cover.

E Remove the misfed paper by
turning the blue knob C as shown
in the illustration.

If you turn the blue knob C clock-
wise (A) , the misfed paper comes
out to the output tray (B).

If you turn the blue knob C coun-
terclockwise (A), remove the mis-
fed paper from inside of the right
cover (B).

F Close the covers in the following
order:

• The right cover

• The duplex unit

• The bypass tray

• The front cover

• The output feeder cover

G Open the covers of the bridge unit
(A) and remove the misfed paper
(B).

H Close the cover of the bridge unit.

TAPH050E

TAPH072E

TAPY191E

TAPY770E
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When "Misfeed:R" Appears

Finisher SR720

A Remove the misfed paper from
the output tray of the Finisher
SR720.

B If you cannot remove the misfed
paper in step A, open the right
cover of the Finisher SR720.

C Remove the misfed paper.

D Close the right cover of the Fin-
isher SR720.

E If you cannot remove the misfed
paper in step C, slide the stack
unit of the Finisher SR720 out (A)
and remove the misfed paper (B).

F Slide the stack unit into the Fin-
isher SR720 until it stops.

Finisher SR730

A Open the front cover of the Fin-
isher SR730.

TAPY630E 

TAPY640E

TAPY650E

TAPY660E 

TAPY240E
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BWhile pushing the blue lever R1
upwards (A), remove the misfed
paper (B).

C If you cannot remove the misfed
paper in step B, remove the mis-
fed paper (A) while pushing the
blue lever R2 downwards in a
clockwise direction (B).

DWhile pushing the blue lever R3
upwards in a clockwise direction
(A), remove the misfed paper
(B).

E Push the lever R4 to the left (A)
and remove the misfed paper (B).

F Return the blue lever R4 to its
original position.

G If you cannot remove the misfed
paper in step F, remove it (B)
while pushing the blue lever R5
upwards in a clockwise direction
(A).

TAPY250E

TAPY260E

TAPY130E

TAPY270E

TAPY280E

TAPY290E
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H Hold the blue lever R6 and pull
out the stack unit (A), then re-
move the misfed paper (B).

I Return the stack unit to its origi-
nal position (A) and close the
front cover of the Finisher SR730
(B).

When "Misfeed:U" Appears

A Open the top cover of the Large
Capacity Tray RT36.

B Remove the misfed paper.

C If you cannot remove the misfed
paper in step B, close the top cover
of the Large Capacity Tray RT36
and pull the lever (A) to extend
the connecting unit (B).

TAPY300E

1

2

TAPY310E

TAPM230E

TAPY160E

1

2

TAPP700E



Troubleshooting

116

9

D Remove the misfed paper from
the left side of the Large Capacity
Tray RT36.

E Slide the Large Capacity Tray
RT36 forward to connect it to the
printer.

When "Misfeed:Y" Appears

Note

❒ If your printer is equipped with
the optional Large Capacity Tray
RT36, pull the lever (A) to extend
the connecting unit (B).

A Open the lower vertical paper
feed cover.

B Remove the misfed paper.

C Close the lower  vertical paper
feed cover.

TAPY170E

TAPP230E
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When "Misfeed:W" Appears

A Open the front cover of the Mail-
box CS360.

B Push the blue lever W1 down-
wards to open the cover inside
(A). Then remove the misfed pa-
per (B).

CWhile pushing the blue lever W1
downwards, return the cover to
its original position.

DWhile opening the W2 cover (A),
remove the misfed paper (B).

E Push the blue button W3 to open
the cover (A), then remove the
misfed paper (B).

F Close the cover and press it down
until it clicks  into place.

G Open the top cover of the Mailbox
CS360.

H Pull the blue lever W5 to the right
to open the cover (A), then re-
move the misfed paper (B).

I Return the cover to its original po-
sition.

TAPY410E
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JWhile pulling the blue lever W6
upwards (A), remove the misfed
paper (B).

K Remove the misfed paper from
the output tray.

L If your printer is equipped with
both the Finisher SR730 and the
Mailbox CS360, open the triangu-
lar cover on the front of the Mail-
box CS360.

M Turn the blue lever W4 counter-
clockwise to open the cover (A),
then remove the misfed paper
(B).

N Turn the blue lever W4 clockwise
to return the cover to its original
position.

O Close the triangular cover and the
front cover of the Mailbox CS360.

TAPY470E
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When "Misfeed:Z" Appears

A Open the bypass tray (A). And
then open the duplex unit by
pushing the catch upwards (B).

B Open the cover Z1 to the left (A),
and remove the misfed paper (B).

C If you cannot remove the misfed
paper in step B, remove it (B)
while opening the cover Z2 to the
left  (A).

D Close the covers in the following
order:

• The cover Z2

• The cover Z1

• The duplex unit

• The bypass tray

TAPH030E

b

a
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Adding Staples

When “Add Staple” appears on the
panel display, the staples have almost
run out. Follow these steps to add a
new staple refill.

Note

❒ After adding the staple refill, sta-
ples might not be ejected for the
first few times.

Finisher SR720

A Slide the stack unit of the Finish-
er SR720 out until it stops.

B Remove the staple cartridge.

C Remove the empty refill case
(white).

D Add a new refill and align the ar-
rows on the refill case and the car-
tridge, and push the refill case in
until it clicks.

E Pull out the ribbon from the bot-
tom of the refill case.

TAPY670E 
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F Slide the cartridge in until it
clicks.

G Slide the stack unit into the Fin-
isher SR720.

Finisher SR730

A Open the front cover of the Fin-
isher SR730 (A), and slide the
stack unit out until it stops (B).

B Lift the staple cartridge until it
clicks, then remove the cartridge
gently.

C Remove the empty refill case
(white).

D Add a new refill and align the ar-
rows on the refill case and the car-
tridge, and push the refill case in
until it clicks.

E Pull out the ribbon from the bot-
tom of the refill case.

TAPY720E 
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F Reinstall the cartridge, and press
down on the cartridge until it
clicks into place.

G Slide the stack unit into the Fin-
isher SR730 (A), and close the
cover (B).

TAPY370E
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Removing Jammed Staples

If staples do not ejected properly,
they might be jammed.

Note

❒ Staples might be jammed because
of curled paper. In this case, try
turning the paper over in the tray.

❒ After removing the jammed sta-
ples, staples might not be ejected
for the first few times.

Finisher SR720

A Slide the stack unit of the Finish-
er SR720 out until it stops.

B Remove the staple cartridge.

C Open the face plate.

D Remove the jammed staples.

E Close the face plate.

F Slide the staple cartridge in until
it clicks.

G Slide the stack unit into the Fin-
isher SR720.

TAPY670E 
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Finisher SR730

A Open the front cover of the Fin-
isher SR730 (A), and slide the
stack unit out until it stops (B).

B Lift the staple cartridge until it
clicks, then remove the cartridge
gently.

C Press the face plate lock down to
open the face plate.

D Remove the jammed staples.

E Close the face plate by pressing it
down until it clicks into place.

F Reinstall the cartridge, and press
the cartridge down until it clicks
into place.
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G Slide the stack unit into the Fin-
isher SR730 (A), and close the
cover (B).

1

2
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Removing Paper Chips

When “Punch Chips Full” appears on
the panel display, the punch waste
box is full. Follow these steps to re-
move paper chips.

A Open the front cover of the Fin-
isher SR730.

B Pull out the punch waste box and
remove the paper chips.

C Reinstall the punch waste box.

D Close the front cover of the Fin-
isher SR730.

TAPY240E

TAPP680E
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Replacing the Toner Bottle

R WARNING:

R CAUTION:

When “Low on Toner” appears on the
panel display, the toner has almost
run out. Prepare a new toner bottle. If
the image density is too light, replace
the old toner bottle with a new one.

When “Replace Toner” appears on
the panel display, the toner bottle is
empty. Prepare a new toner bottle
and replace the old toner bottle with a
new one.

Note

❒ The actual number of printed pag-
es you get from a particular toner
bottle depends on the type and
size of paper you are using, the
contents of your print images, and
printing environment conditions.

A Open the front cover.

B Lift the green handle.

CWhile pushing the green lever to
the right (A), hold the handle and
gently slide the toner holder out
(B).

• Do not incinerate toner (used 
or unused) or toner contain-
ers. Toner dust is flammable 
and might ignite when ex-
posed to an open flame.

• Disposal should take place at 
an authorized dealer or appro-
priate collection site.

• If you dispose of the used ton-
er containers yourself, follow 
local regulations.

• The inside of the machine be-
comes very hot. Do not touch the 
parts with a label indicating a 
“hot surface”. Touching a “hot 
surface” could result in a burn in-
jury.

• Do not eat or swallow toner.

• Keep toner (used or unused) and 
toner containers out of reach of 
children.

• Our products are engineered to 
meet the highest standards of 
quality and functionality. When 
purchasing expendable sup-
plies, we recommend using only 
those specified by an authorized 
dealer.

TAPH071E

TAPT010E

TAPT020E
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D Press the toner bottle backward
(A) to raise its head (B), then
gently pull out the bottle.

EMove the new toner bottle back
and forth about 5 - 6 times as
shown in the illustration.

F Remove the black cap of the new
toner bottle by turning it counter-
clockwise.

Note

❒ After removing the black cap
from the bottle, toner can scatter
easily. Do not shake or jar the
bottle.

G Place the toner bottle on the toner
holder (A), then pull its head to-
ward you (B) to lock it in place.

H Slide the toner holder into the
printer until it clicks into place,
and push down the green handle.

I Close the front cover.

TAPT080E

TAPT040E

TAPT050E

TAPT060E

TAPT070E

TAPH082E
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Menu Chart
This section describes how to change the default settings of your printer and
provides information on the parameters included in each menu.

Category Function Menu

Proof Print

⇒ P.133 “Proof Print Menu”

Print File

Delete File

Show Error Log

Job Control

⇒ P.134 “Job Control Menu”

Paper Input Page Size

Tray Priority

Paper Size

Tray Paper Type

Bypass Pap.Type

Auto Tray SW

Paper Output Output Tray

Duplex

Sort

Staple

Punch

Print Quality Edge Smoothing

Resolution

Image Density

Toner Saving

System Copies

Print PS Errors

Energy Saver

Auto Continue

PCL Menu Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set
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Host Interface

⇒ P.141 “Host Interface 
Menu”

Printer Lang.

Parallel Setup I/O Timeout

Bi-direction

Network Setup I/O Timeout

IP Address

Subnet Mask

Gateway Address

Maintenance

⇒ P.143 “Maintenance 
Menu”

System Reset

Menu Reset

Registration Tray3 Width

Tray4 Width

List Print

⇒ P.144 “List Print Menu”

Config. Page

Menu List

PCL Font List

PS Font List

PCL Demo Page

PS Demo Page

Language ⇒ P.146 “Language Menu”

Category Function Menu
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Accessing the Main Menu

Confirm that the printer is offline. If not, take the printer offline.

Press {Menu} to display the “Main” menu on the panel display.

The “Main” menu has the following six menus, which can be displayed one by
one using {TT} or {UU}.
• Proof Print

• Job Control

• Host Interface

• Maintenance

• List Print

• Language

Note

❒ {TT}: Press to go to the next page.

❒ {UU}: Press to go back to the previous page.

❒ After making the printer's settings, be sure to return to the previous menu by
pressing {Escape}.

❒ After making the printer's settings, press {On Line} to return to the ready con-
dition.

❒ The revised settings are not canceled even if the printer power is turned off.
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Making Printer Settings with the Operation 
Panel

A Press {Menu}. 
The “Main” menu appears.

B Search for the desired menu with {T} or {U}.
The desired menu appears.

C Press {Enter}.

D Search for the desired menu with {T} or {U}.
The desired menu or parameter appears.

Note

❒ “p” shown in front of the item indicates that item is currently selected.

E Press {Enter}.
The specified item appears.

F  If necessary, repeat steps D and E until you complete the desired settings.

Note

❒ {Escape}: Press to return to the previous menu. If you press this key before
pressing {Enter}, the adjusted data is canceled.
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Proof Print Menu

There are 3 menus in the “Proof Print” menu.

• Print File

• Delete File

• Show Error Log

Reference

For details on the “Proof Print”, see P.154 “Specifications”.

Proof Print Parameters

❖ Proof Print

Menu Description

Print File Select a proof print file and print.

Delete File Select a proof print file and delete.

Show Error Log Show the error log in the proof print job.
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Job Control Menu

There are 5 menus in the “Job Control” Menu.

• Paper Input

• Paper Output

• Print Quality

• System

• PCL Menu

Job Control Parameters

❖ Paper Input 1/3

Menu Description

Page Size In DOS printing, you should select the page size here when 
it is not specified in the applications.

A4, B5 JIS, A5, A6, 11x17, 8.5x14, 8.5x13, 8.25x13, 8x13, 
7.25x10.5, 5.5x8.5, 8.5x11, A3, B4 JIS

Note

❒ Default: A4 (Metric Version), 8.5x11 (Inch Version)

Tray Priority You can specify the default tray. The tray selection speci-
fied with the printer driver overrides the one specified here. 
In DOS printing, the tray specified here is used, when no 
tray is specified for a print job.

Auto, Tray1, Tray2, Tray3, Tray4, BYPASS, LCT

Note

❒ Default: Auto

❒ Only the installed trays appear on the panel display.

❒ It is recommended that you load paper having the size 
and direction you frequently use in the tray selected 
with the “Tray Priority”.
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❖ Paper Input 2/3

Menu Description

Page Size You should specify the paper size for those not indicated on 
the paper size dials of the Tray 1, Tray 2, Tray 3 and Tray 4.

When you specify the sizes that are not indicated on the pa-
per size dial of Tray 1, Tray 2, Tray 3 or Tray 4, you should 
set the dial to “p” and then specify the paper size here.

❖ Tray 1
For information on paper sizes that can be set in Tray 1, 
see P.85 “Paper and Other Media”.

❖ Tray 2
For information on paper sizes that can be set in Tray 2, 
see P.85 “Paper and Other Media”.

❖ Tray 3 (option)
For information on paper sizes that can be set in Tray 3, 
see P.85 “Paper and Other Media”.

❖ Tray 4 (option)
For information on paper sizes that can be set in Tray 4, 
see P.85 “Paper and Other Media”.

Note

❒ Only the installed trays appear on the panel display.

Tray Paper Type You can specify the type of the paper in Tray 1, Tray 2, Tray 
3, Tray 4 and Large Capacity Tray RT36.

If you want to specify the paper type, do not select "Auto" 
in the "Tray Priority" menu. Select the tray you want to use.

• Plain Paper

• Recycled Paper

• Special Paper

Note

❒ Default: Plain Paper

❒ "Special Paper" refers to a paper type other than plain 
paper or recycled paper, such as colored paper.

❒ Only the installed trays appear on the panel display.

❒ If you select "Special Paper" for all trays, the paper is fed 
from the tray you selected in the "Tray Priority" menu.

❒ If you select "Auto" in the "Tray Priority" menu, the 
printer automatically chooses the tray having plain pa-
per. If no tray has plain paper, the printer chooses the 
tray having recycled paper.
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❖ Paper Input 3/3

❖ Paper Output 1/2

Menu Description

Bypass Pap.Type

(Bypass Paper Type)

You can specify the type of the paper in bypass tray.

• Plain Paper

• OHP Sheet

• Thick Paper

Note

❒ Default: Plain Paper

Auto Tray SW

(Auto Tray Switch)

When paper runs out in the currently selected tray, you can 
specify whether or not the printer chooses another tray that 
has the same paper in size, media type and feed direction.

• On

• Off

Note

❒ Default: On

Menu Description

Output Tray You can specify the output tray for printing.

The tray selection specified with the printer driver over-
rides the one specified here.

Standard Tray, Finisher Proof, Finisher Shift, Mailbox 
Proof, Mailbox Tray1, Mailbox Tray2, Mailbox Tray3, Mail-
box Tray4, Mailbox Tray5, Mailbox Tray6, Mailbox Tray7, 
Mailbox Tray8, Mailbox Tray9

Note

❒ Default: Standard Tray

❒ Only the installed trays appear on the panel display.

Duplex You can specify the direction for duplex printing.

• Off

• Long Edge Bind.

• ShortEdge Bind.

Note

❒ Default: Off
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❖ Paper Output 2/2

Menu Description

Sort You can specify the type of sort printing.

• Off

• Offset Sort

• Rotate Sort

Note

❒ Default: Off

Staple You can specify the position where you want paper to be 
stapled.

❖ Finisher SR720

• Off

• On

❖ Finisher SR730
Off, Left Slant, Right Slant, Lest 2, Right 2, Left Horiz., 
Right Horiz., Left Vert., Right Vert., Left, Right 

Note

❒ Default: Off

❒ The selection depends on which option is equipped with 
your printer.

Reference

⇒ P.151 “Stapling Position and Punch Position”

Punch You can specify the position where you want the paper to 
be punched.

• Off

• Left

• Right

• Top

Note

❒ Default: Off

❒ Punch is available when the optional Punch Kit Type 
450 is installed with the optional Finisher SR730.

Reference

⇒ P.151 “Stapling Position and Punch Position”
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❖ Print Quality

Menu Description

Edge Smoothing You can specify whether the Edge Smoothing feature is en-
abled.

• On

• Off

Note

❒ Default: On

Resolution You can specify the print resolution in dots per inch.

• 600 dpi (PCL 5e, PCL 6, PS)

• 300 dpi (PCL 5e)

Note

❒ Default: 600 dpi

❒ The resolution specified with the printer driver over-
rides the one specified here.

Image Density You can specify the print image density.

Very Light, Light, Normal, Dark, Very Dark

Note

❒ Default: Normal

Toner Saving You can specify whether or not the Toner Saving feature is 
enabled.

• Off

• On

Note

❒ Default: Off
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❖ System

Menu Description

Copies You can specify the number of copies you want to make.

1- 999

Note

❒ Default: 1

❒ The number specified with the printer driver overrides 
the one specified here.

Print PS Errors You can specify whether the PS error sheet should be print-
ed out.

• Off

• On

Note

❒ Default: Off

Energy Saver You can specify the time the printer should wait before 
turning into Energy Saver mode. Energy Saver mode re-
duces electric power consumption.

0 minute, 15 minutes, 30 minutes, 1 hour, 2 hours, 3 hours

Note

❒ Default: 1 hour

❒ If there is an error in your printer, the printer will not 
turn into the Energy Saver mode.

❒ When the printer switches to Energy Saver mode, the 
Power indicator turns off, the On Line indicator blinks, 
and “Energy Save Mode” is displayed on the panel dis-
play.

Auto Continue You can specify the time the printer should wait before can-
celling a job after an error occurs. If it is set to “Off”, the 
print job is automatically reset when an error occurs.

Off, 15 seconds, 30 seconds, 60 seconds, 180 seconds, 300 
seconds

Note

❒ Default: Off
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❖ PCL Menu

Menu Description

Orientation You can specify the page orientation.

The tray selection specified with the printer driver over-
rides the one specified here.

• Portrait

• Landscape

Note

❒ Default: Portrait

Form Lines You can specify the number of lines per page.

5-128

Note

❒ Default: 64 (Metric version), 60 (Inch version)

Font Source You can specify the location of the default font.

• Internal

• Download

Note

❒ Default: Internal

Font Number You can specify the ID for the default font you want to use.

• 0 to 52 (for Internal)

• 1 to N (for Download source)

Note

❒ Default: 0

❒ “N” depends on how many fonts you have download-
ed.

Point Size You can specify the value for the point size you want to use 
for the selected font.

4.00 to 999.75 by 0.25 

Note

❒ This setting is effective only for a variable-space font.

Font Pitch You can specify the number of characters per inch you want 
to use for the selected font.

0.44 to 99.99 by 0.01

Note

❒ This setting is effective only for a fixed-space font.

Symbol Set You can specify the set of print characters for the selected 
font. The available options are as follows.

Roman-8, Win L1, Win L2, Win L5, Win Baltic, Win 3.0, Le-
gal, ISO L1, ISO L2, ISO L5, ISO 1, ISO 4, ISO 6, ISO 11, ISO 
15, ISO 17, ISO 21, ISO 60, ISO 69, PC-8, PC-850, PC-852, PC-
1004, PC-8 D/N, PC8-TK, VN Math, VN US, VN Intl, MS 
Publ, Pifont, Desktop, Math-8, PS Math, PS Text, MC Text

Note

❒ Default: Roman-8
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Host Interface Menu

There are 3 menus in the “Host Interface” Menu.

• Printer Lang. (Printer Language)

• Parallel Setup

• Network Setup ⇒ P.20 “Configuring the Printer for the Network with the Opera-
tion Panel”

Host Interface Parameters 

❖ Printer Lang. (Printer Language)

❖ Parallel Setup

Menu Description

Printer Lang.

(Printer Language)

You can specify the printer language you want to use for 
the print jobs. When ”Auto Sense” is specified, the printer 
will automatically switch from one language to the right 
one.

• Auto Sense

• PCL

• PS

Note

❒ Default: Auto Sense

Menu Description

I/O Timeout You can specify the time your printer should wait before 
ending a print job. If data from other ports often appears in 
the middle of your print job, you should increase the time-
out value.

15 seconds, 30 seconds, 60 seconds, 180 seconds, 300 sec-
onds

Note

❒ Default: 30 seconds

Bi-direction You can specify the printer response mode for status fetch 
requests when the standard parallel interface is being used. 
Set this feature to “Off” when you are experiencing prob-
lems while the printer is connected to another manufactur-
er's print box.

• On

• Off

Note

❒ Default: On
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❖ Network Setup

Menu Description

I/O Timeout You can specify the time your printer should wait before 
ending a print job. If data from other ports often appears in 
the middle of your print job, you should increase the time-
out value.

15 seconds, 30 seconds, 60 seconds, 180 seconds, 300 sec-
onds

Note

❒ Default: 30 seconds

IP Address You can specify the IP Address.

Note

❒ Default: All zero

Subnet Mask You can specify the Subnet Mask. 

Note

❒ Default: All zero

Gateway Address You can specify the Gateway Address.

Note

❒ Default: All zero
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Maintenance Menu

There are 3 menus in the “Maintenance” Menu.

• System Reset

• Menu Reset

• Registration

Maintenance Parameters 

❖ System Reset

❖ Menu Reset

❖ Registration

Menu Description

System Reset You can initialize the printer, returning all settings to the 
factory default.

Menu Description

Menu Reset You can reset the menu settings to the factory default.

Menu Description

Tray3 Width You can change the position of the printed image on the pa-
per fed from Tray 3 so that it can match that of the standard 
paper tray.

from –9.0 to 9.0

Note

❒ Default: 0

Tray4 Width You can change the position of the printed image on the pa-
per fed from Tray 4 so it can match that of the standard pa-
per tray.

from –9.0 to 9.0

Note

❒ Default: 0
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List Print Menu

There are 6 menus in the “List Print” Menu.

• Config. Page

• Menu List

• PCL Font List

• PS Font List

• PCL Demo Page

• PS Demo Page

List Print Parameters 

❖ List Print

Printing the Test Page

You can confirm that the printer works properly by printing a test page (config-
uration page).

However, you cannot check the connection between the printer and your com-
puter by printing the test page.

A Confirm that the printer power is turned on.

B Press {Menu}.
The following message appears on the panel display.

  Main Menu:

   Proof Print

Menu Description

Config. Page You can print the current configuration of the printer. 

Menu List You can print the Menu List which shows the function 
menu of this printer.

PCL Font List You can print a list of the installed PCL font.

PS Font List You can print a list of the installed PS font.

PCL Demo Page You can print a PCL demonstration page which shows in-
formation about the printer.

PS Demo Page You can print a PS demonstration page which shows infor-
mation about the printer.
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C Press {T} or {U} until the following message appears on the panel display.

  Main Menu:

   List Print

D Press {Enter}.
The following message appears on the panel display.

  List Print:

   Config. Page

E Press {Enter}.
The following message appears on the panel display.

  Config. Page:

  Press Enter (#)

F Press {Enter}.
In a short time, the test printing will start.

Important

❒ If you cannot complete the test printing correctly, check if an error message
appears on the panel display. For more information on error messages, see
P.99 “Troubleshooting”.
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Language Menu

You can select the language you use. Available languages are as follows:

• Metric version
English, Germany, French, Italian, Dutch, Swedish, Norwegian, Danish,
Spanish, Finnish, Portuguese, Czech, Polish, Hungarian

• Inch version
English, French, Spanish

Note

❒ Default: English

❒ If you want to use the English panel display, it is not necessary to change this
setting.
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Printing with the Operation Panel

Using the Proof Print

Use this function to print only one
copy of a multiple copy print job. The
other copies are saved in the printer.
The saved job can be printed from the
printer's operation panel.

Note

❒ If the application has a collate op-
tion, make sure that it is not select-
ed before sending a print job. By
default, proof print jobs are auto-
matically collated by the printer
driver. If the collate option is se-
lected from the application print
dialog box, more copies than in-
tended may be printed.

❒ You can identify the file you want
to print by the User IDs and the
time when the job was stored.

Reference

⇒ P.154 “Specifications”

Printing a Proof Print File

A Press {Menu}.
The following message appears on
the panel display.

  Main Menu:

   Proof Print

B After confirming that “Proof
Print” is displayed, press {Enter}.

C After confirming that “Print File”
is displayed, press {Enter}.

  Proof Print:

   Print File

D Press {T} or {U} to display a file
you want to print, and then press
{Enter}.

  Print File:    

   08:56 ABCD1234

The following message appears on
the panel display.

  Q'ty(1-999):   1

  Press Enter (#)   

E Press {U} or {T} to set the
number of copies.

Note

❒ You can set the number of cop-
ies up to 999.

  Q'ty(1-999):   6

  Press Enter (#)

F Press {Enter}.

Deleting a Proof Print File

If the printed document is not what
you expect, you can delete the proof
print file. You can then revise them
and print again until the settings be-
come OK.

A Press {Menu}.

B After confirming that “Proof
Print” is on the display, press {En-
ter}.

  Main Menu:

   Proof Print
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C Press {T} or {U} until “Delete
File” appears, and then press {En-
ter}.

  Proof Print:

   Delete File

D Press {T} or {U} to display the
file you want delete, and then
press {Enter}.

  Delete File:  

   22:07 EFGH5678

The following message appears on
the panel display.

  22:07 EFGH5678: 

  Delete=Enter (#)

E Press {Enter}.
This starts deleting a proof print
file after the following message ap-
pears on the panel display.

  Deleted       

  

Checking the Error Log

A Press {Menu}.

B After confirming that “Proof
Print” is on the display, press {En-
ter}.

  Main Menu:

   Proof Print

C Press {T} or {U} until “Show Er-
ror Log” appears, and then press
{Enter}.

  Proof Print:

   Show Error Log

The following message appears on
the panel display.

  Show Error Log:

   12:46 IJKL9012

Note

❒ You can check the other error
logs by using {TT} or {UU}.

❒ Press {Escape} to return to the
previous menu.
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Interpreting the Configuration Page

Reference

❖ Printer ID
Shows the serial number of the printer.

❖ Firmware Version
Shows the version number of the printer PCL firmware. 

❖ Pages Printed
Shows the total number of pages printed.

Memory

❖ Total Memory
Shows the total amount of memory (SIMM) installed on the printer. 

❖ Proof Print Free Memory (%)
Shows the amount of hard disk space (as a percentage) that is available for
proof print jobs.

❖ Font Download Total Memory
Shows the total memory used by the downloaded fonts.

❖ Font Download Free Memory
Shows the amount of memory that is available for font downloads.

Options

Shows the options installed on the printer.

Job Control

Shows the settings you make with the “Job Control” menu.

Reference

For more information on the “Job Control”, see P.134 “Job Control Menu”.

Host Interface

Shows the settings you make with the “Host Interface” menu.

Reference

For more information on the “Host Interface” Menu, see P.141 “Host Interface
Menu”.



Using the Operation Panel

150

10



151

11. Appendix

Stapling Position and Punch Position

You can select a stapling or punch position among those listed in the following table.

❖ Finisher SR720

❖ Finisher SR730

Stapling position

TAPY810E

Feed
direction Orientation Stapling position

Portrait

Portrait

Landscape

Landscape

Stapling position Punch position

TAPY760E

Feed
direction Orientation Stapling position

Feed
direction Orientation Punch position

Portrait

Portrait Portrait

Portrait

Landscape Landscape

LandscapeLandscape
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Memory Capacity and Paper Size

The standard 8 MB is enough for the machine to work with all options, using
PCL or PostScript (however, the optional printer hard disk is needed to down-
load PCL 5e fonts and PS fonts).

Note

❒ This allows 600 dpi printing in duplex mode with A3L/11” × 17”L size pa-
per.

However, for faster printing of complex pages or when using a lot of fonts, add
more memory.
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Moving and Transporting the Printer

R CAUTION:

When transporting, repack the printer with its original packing materials.

Important

❒ Be sure to disconnect all cables from the printer before transporting it.

❒ The printer is a precision piece of machinery. Take care to avoid damage dur-
ing shipment.

• When lifting the machine, use the grips on both sides of the machine. If you 
drop the machine, it could break or cause an injury.

• When you move the machine, remember to unplug the power cord from the 
outlet. When you pull the plug out of the socket, hold it by the plug. If the 
cord is pulled out of the socket abruptly, it could become damaged. Dam-
aged plugs or cords can cause an electrical or fire hazard.
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Specifications

Mainframe

❖ Configuration:
Desktop

❖ Print Process:
Laser beam scanning & Electrophotographic printing
Dualcomponent development

❖ Printing Speed:
Maximum 45 pages per minute (A4K, 81/2" × 11"K, simplex)
Maximum 36 pages per minute (A4K, 81/2" × 11"K, duplex)

❖ Parallel Interface: 
Interface
A standard 36–pin printer cable and a parallel port on the host computer
Mode
IEEE 1284 Compatible, ECP, Nibble

❖ Network Cable
10BASE-T/100BASE-TX shielded twisted-pair (STP) cable

❖ Network: 
Topology
Ethernet 10BASE-T/100BASE-TX
Protocol
IPX/SPX, TCP/IP, AppleTalk

❖ Resolution:
600 × 600 dpi (PCL 5e, PCL 6, PS)
400 × 400 dpi (PS)
300 × 300 dpi (PCL 5e)

❖ Printer Language:
PCL 5e emulation, PCL 6 (5e+XL) emulation, Adobe PostScript Level 3 

• Automatic language switching (Auto Sense)

❖ Fonts:
PCL 5e, PCL 6
35 Intellifonts, 10 True Type fonts, and 1 Bitmap font
Font Manager available, plus 61 additional fonts. ⇒ P.69 “Installing the Font
Manager”
PostScript
136 Adobe Type 1 fonts
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❖ Paper size:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Paper Weight:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Power Source:
⇒ inside of the front cover of this manual

❖ Power Consumption:

❖ Noise Emission *1 :

❖ Sound Power Level

❖ Sound Pressure Level *2 

*1 The above measurements made in accordance with ISO 7779 are actual value.
*2 It is measured at the position of the bystander.

❖ Dimensions:

*1 Finisher SR730, Mailbox CS360, Bridge Unit Type 450, Large Capacity Tray RT36
and paper bank PS430.

❖ Weight:
Approximately 62 kg (136.7 lb) (power cord included)

Maximum 1,200 W or less

Printing 1,000 W or less

Energy Saver Mode 45 W or less

Mainframe only

During printing 70 dB (A)

Stand-by 42 dB (A)

Mainframe only

During printing 58 dB (A)

Width Depth Height

Printer only (bypass 
tray not extended)

665 mm (26.2") 640 mm (25.2") 570 mm (22.4")

Printer with paper 
bank (bypass tray 

not extended)

665 mm (26.2") 640 mm (25.2") 820 mm (32.3")

Printer with full op-

tions *1  (bypass tray 
extended)

2,140 mm (84.3") 640 mm (25.2") 970 mm (38.2")
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❖ Warm-up Time:
Less than 100 seconds (68 °F)

❖ Paper Capacity:

*1 Paper weight: 80 g/m2, 20 lb

❖ Paper Output Capacity:
500 sheets (80 g/m2, 20 lb)
If the paper is curled or if you use the guides, the output capacity is reduced.

❖ Memory:
Standard 8 MB, up to 72 MB (with SIMM module)

❖ Number of Proof Prints:

• The actual number of pages the printer can save depends on the contents
of the print images. For example, the printer can save a number of proof
print files equal in size to 965 pages of the configuration page.

• If the first copy of the proof print file is not what you expected and you do
not want to print the remaining copies, delete the proof print file using the
operation panel. If you print the remaining copies of the proof print file,
the job in the printer is deleted automatically.

❖ Options:

• Paper Bank PS430

• Large Capacity Tray RT36

• Finisher SR720

• Finisher SR730

• Punch Kit Type 450

• Mailbox CS360

• Bridge Unit Type 450

• Bridge Unit Type 460

• Hard Disk Drive Type 450

Standard paper tray 500 sheets × 2  *1 

Bypass tray 50 sheets *1 

Optional paper bank 500 sheets × 2  *1 

Optional large capacity tray 1,500 sheets  *1 
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Options

Paper Bank PS430

❖ Paper size:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Paper weight:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Maximum power consumption:
50 W (power is supplied from the main frame.)

❖ Paper capacity:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Dimensions (W × D × H):
540 × 600 × 270 mm (21.3” × 23.7” × 10.7”)

❖ Weight:
Approx. 25 kg (55.2 lb)

Note

❒ Specifications are subject to change without notice.

Large Capacity Tray RT36

❖ Paper size:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Paper weight:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Paper capacity:
⇒ P.85 “Paper and Other Media Supported by Your Printer”

❖ Power consumption:
Approx. 40 W (power is supplied from the main frame.)

❖ Dimensions (W × D × H):
390 × 500 × 390 mm (15.4” × 19.7” × 15.4”)

❖ Weight:
Approx. 17 kg (37.5 lb)
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Finisher SR720

❖ Paper size:
A3L, B4 JISL, A4KL, B5 JISKL, A5L, A6L, 11” × 17”L, 81/2” × 14”L,
81/2” × 11”KL, 51/2” × 81/2”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” ×
13”L, 8” × 13”L

❖ Paper weight:
52 – 157 g/m2 (14 – 42 lb)

❖ Stack capacity:

• 1,000 sheets (A4K, 81/2” × 11”K or smaller) (80 g/m2, 20 lb)

• 500 sheets (B4 JISL, 81/2” × 14”L or larger) (80 g/m2, 20 lb)

❖ Staple capacity:

• 30 sheets (A4K, 81/2” × 11”K or smaller) (80 g/m2, 20 lb)

• 20 sheets (B4 JISL, 81/2” × 14”L or larger) (80 g/m2, 20 lb)

❖ Staple paper size:
A3L, B4 JISL, A4KL, B5 JISKL, 11” × 17”L, 81/2” × 14”L, 81/2” ×
11”KL

❖ Staple paper weight:
64 – 80 g/m2 (17 – 20 lb)

❖ Staple position:
⇒ P.151 “Stapling Position and Punch Position”

❖ Power consumption:
48 W (power is supplied from the main frame.)

❖ Dimensions (W × D × H):
568 × 520 × 625 mm (22.4” × 20.5” × 24.6”)

❖ Weight:
Approx. 21 kg (46.3 lb)

Finisher SR730

Shift Tray:

❖ Paper size:
A3L, B4 JISL, A4KL, B5 JISKL, A5L, A6L, 11” × 17”L, 81/2” × 14”L,
81/2” × 11”KL, 51/2” × 81/2”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” ×
13”L, 8” × 13”L
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❖ Paper weight:
52 – 157 g/m2 (14 – 42 lb)

❖ Stack capacity:
without punch:

• 3,000 sheets (A4K, 81/2” × 11”K) (80 g/m2, 20 lb)

• 1,500 sheets (A3L, B4 JISL, A4L, B5 JISKL, 11” × 17”L) (80 g/m2, 20
lb)

with punch (the optional punch kit is required):

• 2,500 sheets (A4K, 81/2” × 11”K) (80 g/m2, 20 lb)

• 1,500 sheets (A3L, B4 JISL, A4L, B5 JISKL, 11” × 17”L, 81/2” × 14”L,
81/2” × 11”L) (80 g/m2, 20 lb)

Proof Tray:

❖ Paper size:
A3L, B4 JISL, A4KL, B5 JISKL, A5L, A6L, 11” × 17”L, 81/2” × 14”L,
81/2” × 11”KL, 51/2” × 81/2”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” ×
13”L, 8” × 13”L

❖ Paper weight:
52 – 157 g/m2 (14 – 42 lb)

❖ Stack capacity:
without punch:

• 250 sheets (A4KL, 81/2” × 11”KL or smaller) (80 g/m2, 20 lb)

• 50 sheets (B4 JISL, 81/2” × 14”L or larger) (80 g/m2, 20 lb)
with punch (the optional punch kit is required):

• 200 sheets (A4KL, 81/2” × 11”KL or smaller) (80 g/m2, 20 lb)

• 50 sheets (B4 JISL, 81/2” × 14”L or larger) (80 g/m2, 20 lb)

Staple:

❖ Staple capacity:
without punch:

• 50 sheets (A4KL, 81/2” × 11”KL or smaller) (80 g/m2, 20 lb)

• 30 sheets (B4 JISL, 81/2” × 14”L or larger) (80 g/m2, 20 lb)
with punch (the optional punch kit is required):

• 40 sheets (A4KL, 81/2” × 11”KL or smaller) (80 g/m2, 20 lb)

• 25 sheets (B4 JISL, 81/2” × 14”L or larger) (80 g/m2, 20 lb)

❖ Staple paper size:
A3L, B4 JISL, A4KL, B5 JISKL, 11” × 17”L, 81/2” × 11”KL, 81/2” ×
14”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” × 13”L, 8” × 13”L
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❖ Staple paper weight:
64 – 80 g/m2 (17 – 20 lb)

❖ Staple position:
⇒ P.151 “Stapling Position and Punch Position”

❖ Power consumption:
48 W (power is supplied from the main frame.)

❖ Dimensions (W × D × H):
625 × 545 × 960 mm (24.7” × 21.5” × 37.8”)

❖ Weight:
Approx. 45 kg (99.3 lb)

Punch Kit Type 450

Note

❒ Optional unit for the Finisher SR730.

❖ Paper size (2 holes version):
A3L, B4 JISL, A4KL, B5 JISKL, A5KL, 11” × 17”L, 81/2” × 11”KL,
51/2” × 81/2”KL, 81/2” × 14”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” ×
13”L, 8” × 13”L

❖ Paper size (3 holes version):
A3L, B4 JISL, A4K, B5 JISK, 11” × 17”L, 81/2” × 11”K

❖ Paper weight:

• 2 holes version: 52 – 128 g/m2 (14 – 34 lb)

• 3 holes version: 52 – 105 g/m2 (14 – 28 lb)

❖ Punch position:
⇒ P.151 “Stapling Position and Punch Position”

❖ Power consumption:
33.6 W (power is supplied from the 3000–sheet finisher.)

❖ Dimensions (W × D × H):
92 × 463 × 100 mm (3.7” × 18.3” × 4.0”)

❖ Weight:
2.4 kg (5.3 lb)
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Mailbox CS360

❖ Number of trays:
9 bins, 1 Proof Tray

❖ Paper size:
Bin 1 to 9:
A3L, B4 JISL, A4KL, B5 JISKL, A5L, 11” × 17”L, 81/2” × 14”L, 81/2”
× 11”KL, 51/2” × 81/2”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” × 13”L, 8”
× 13”L
Proof Tray:
A3L, B4 JISL, A4KL, B5 JISKL, A5L, A6L, 11” × 17”L, 81/2” × 14”L,
81/2” × 11”KL, 51/2” × 81/2”L, 71/4” × 101/2”L, 81/4” × 13”L, 81/2” ×
13”L, 8” × 13”L

❖ Paper weight:
Bin: 60 to 90 g/m2 (16 to 24 lb)
Proof: 52 to 157 g/m2 (14 to 42 lb)

❖ Paper capacity:
Bin: 100 sheet per tray (A4K, 81/2” × 11”K, 80 g/ m2 ) / 70 sheets per tray
(Others)
Proof: 500 sheet per tray (A4K, 81/2” × 11”K, 80 g/ m2) / 300 sheets per tray
(Others)

❖ Power consumption:
48 W

❖ Dimensions (W × D × H):
600 × 545 × 980 mm (23.7” × 21.5” × 38.6”)

❖ Weight:
Approx. 37 kg (82 lb)

Hard Disk Drive Type 450

❖ Storage capacity:
1.6 GB
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A

adhesive labels,   91

B

BOOTP Lite,   23
Bridge Unit Type 450,   12
Bridge Unit Type 460,   12
bypass tray,   5

C

cable,   154
Caution,   ii
Config. Page,   144
configuration,   26, 31, 36, 48, 49
configuration page,   149
configuration programs,   23

D

Data In indicator,   7, 104
Delete File,   133

development unit,   6
DHCP,   22
duplex unit,   5
duplex unit right cover,   5

E

Energy Star,   v
Enter key,   8
Error indicator,   7, 102

error & status messages,   99
Escape key,   8, 131
EtherTalk,   48

F

Finisher SR720,   12, 120, 123, 158
Finisher SR730,   12, 121, 124, 158
Firmware Version,   149
Font Download Free Memory,   149

Font Download Total Memory,   149
Font Manager,   69, 71
fonts,   154
Form Feed key,   8
front cover,   4
fusing unit,   6

G

gateway address,   20
guides,   9

H

Hard Disk Drive Type 450,   13, 161
Host Interface,   141, 149

I

IP Peer-to-Peer,   23
IP address,   20, 22
IP Peer-to-Peer,   26, 32

IPX Peer-to-Peer,   23, 28

J

Job Control,   134, 149
Job Reset key,   8

L

Language,   146
Large Capacity Tray RT36,   12, 157
List Print,   144
lower vertical paper feed cover,   5
LPR,   34

M

Macintosh,   48
canceling a print job,   84
PostScript, installing,   63
PostScript, uninstalling,   67
setting up,   81

Mailbox CS360,   12, 161

Maintenance,   143
MAP,   23
media,   85, 93
memory,   149, 152, 156
memory unit,   14
menu,   131

menu chart,   129
Menu key,   8, 131, 132
Menu List,   144
Menu Reset,   143
misfeed,   108
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N

NetBEUI,   31
NetWare,   23, 36
network,   20, 154

network cable connector,   4
Network Setup,   141
NIB Setup Tool,   24, 36
NWSetup,   23

O

OHP transparency,   90
On Line indicator,   7, 102
On Line key,   8, 102, 131

Operating Instructions,   vi
operation panel,   4, 7, 129
options,   11, 149, 156, 157
output tray,   4

P

Pages Printed,   149
panel display,   7
paper,   85, 93

paper bank,   4, 12, 16, 157
Paper Input,   134
Paper Output,   134
paper, sizes, types,   85
paper tray,   4
parallel interface connector,   4
Parallel Setup,   141
PCL 5e,   3, 51, 56, 73
PCL 6,   3, 51, 56, 73
PCL Demo Page,   144
PCL Font List,   144

PCL Menu,   134
Peer-to-Peer,   26, 31
plain paper,   90
PostScript,   3, 59, 66, 77
PostScript 3 Operating Instructions Sup-
plement,   vi
PostScript Printer Driver,   59, 66

power cord,   5
Power indicator,   7
power switch,   4
PPD,   64
printer board,   4
printer driver,   3
Printer ID,   149
Printer Lang.,   141
Printer Port,   29, 33

Print File,   133

Print Quality,   134
Proof Print,   133, 147
Proof Print Free Memory (A4),   149
PS430,   4, 12, 16, 157
PS Demo Page,   144
PS Font List,   144

punch,   151
Punch Kit Type 450,   160
punch waste box,   126

Q

Quick Installation Guide,   vi

R

reference,   149
Registration,   143
right cover,   6

S

screwdriver,   13

Show Error Log,   133
SIMM,   14, 156
specifications,   154
staple,   120, 123, 151
subnet mask,   20
System,   134

System Reset,   143

T

TCP/IP,   22, 31
toner bottle,   127
toner holder,   6
toner lock handle,   6
Total Memory,   149

transfer unit,   6
translucent paper,   91
troubleshooting,   99

U

UNIX,   49
upper vertical paper feed cover,   5

V

ventilator,   5
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W

Warning,   ii
Windows 3.1x

canceling a print job,   82
Font Manager, installing,   69

Font Manager, uninstalling,   71
PCL 5e, installing,   52
PCL 5e, uninstalling,   56
PCL 6, installing,   52
PCL 6, uninstalling,   56
PostScript, installing,   60

PostScript, uninstalling,   66
printer setting dialog box, PCL,   74
printer setting dialog box, PostScript,
78

Windows 95/98
canceling a print job,   82
configuration,   26
Font Manager, installing,   69

Font Manager, uninstalling,   71
PCL 5e, installing,   51
PCL 5e, uninstalling,   56
PCL 6, installing,   51
PCL 6, uninstalling,   56
PostScript, installing,   59

PostScript, uninstalling,   66
printer properties, PCL,   73
printer properties, PostScript,   77

Windows NT 4.0
canceling a print job,   83
configuration,   31
Font Manager, installing,   69

Font Manager, uninstalling,   71
PCL 5e, installing,   53
PCL 5e, uninstalling,   57
PCL 6, installing,   53
PCL 6, uninstalling,   57
PostScript, installing,   61

PostScript, uninstalling,   66
printer properties, PCL,   75
printer properties, PostScript,   79
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